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Abstract 

Modeling of the human temporal bone  

for virtual reality surgical training 
Daniel Sieber 

 

Simulators can be a very useful tool for the training of surgeons, especially as educational aspects of 

surgical residency have come under rising pressure due to work hour restrictions and increasing 

economization of surgical time. While it has been shown that temporal bone simulators can improve 

the efficiency of cadaveric training, high-fidelity anatomy models and variable practice conditions may 

be needed for more advanced learner levels. Existing simulator systems either feature anatomy 

models of low-quality or are limited to constant practice training as only one anatomy is available. To 

overcome this limitation, a novel process was developed within the framework of this dissertation 

which allows the relative efficient production of high-fidelity anatomical computer models as well as 

their implementation in virtual reality surgical simulation.  

Eight fresh adult human temporal bones were digitized using Cone Beam Computed Tomography 

(CBCT) and destructive micro-slicing by serial grinding and optical imaging. The resulting multimodal 

image stacks were reconstructed and registered in 3D. Segmentation of critical structures was 

performed using threshold-based techniques for bone structures and threshold supported manual 

techniques for soft tissue structures.  

Six anatomies could successfully be implemented into the Visible Ear Simulator software complete 

with instructional guides for different temporal bone surgical procedures. The CBCT and micro-slicing 

datasets were combined to achieve this, with a CBCT based geometry model for haptic simulation 

working in a concerted way with the micro-slicing color based visual model. Manual tinting was applied 

in segments which had compromised appearance as an artefact of specimen preparation for micro-

slicing. Along the same lines, some bony defects in the drillable segments as a result of artefacts in 

CBCT imaging were manually corrected.  

The publication of the OpenEar datasets and their implementation into the Visible Ear Simulator mark 

the beginning of a new era in surgical simulation of otologic surgery. It will now be possible to study 

the effects of task variability in temporal bone surgical training without having to make compromises 

when it comes to the visual quality of the underlying datasets. This is expected to increase trainee’s 

performance in simulation training due to the better development of a Generalized Motor Program 

and training the surgeons attention to more anatomical variables. While patient specific surgical 

rehearsal is still hindered by clinical imaging fidelity, the processes developed within this dissertation 
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could prove essential in the creation of training data for machine learning techniques powering such 

simulations and clinical Augmented Reality applications in the future. 

Interactive apps featuring high-fidelity 3D anatomy models as described here, could become an 

important addition to conventional textbooks for medical students. Residents can increase their 

understanding of the anatomy and make cadaveric dissection training more efficient by using surgical 

simulators. With the current work, surgical simulators are expected to also stay relevant for 

intermediate learners who need high-fidelity anatomy models and the option to train in different 

anatomies to create variable practice conditions. Additional studies will be needed to further develop 

the evidence basis allowing a more widespread and systematic use of surgical simulators in surgical 

training curricula.  
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Kurzzusammenfassung 

Modellierung des humanen Felsenbeins  

für das chirurgische Training in virtueller Realität 
Daniel Sieber 

 

Chirurgisches Training im Simulator kann ein sehr nützliches Element in der Ausbildung von Chirurgen 

darstellen, insbesondere da Lehraspekte in der Facharztausbildung durch Arbeitszeitbeschränkungen 

und einer zunehmenden Ökonomisierung der Zeit im Operationssaal unter Druck geraten. Während 

der positive Effekt von Simulatoren auf die Effizienz des Trainings im Felsenbeinpräparat bereits 

gezeigt werden konnte, wird angenommen, dass für fortgeschrittene Lernende anatomische Modelle 

hoher Qualität und abwechslungsreiche Trainingsszenarien benötigt werden. In den bislang 

verfügbaren Simulator Systemen sind hingegen die anatomischen Modelle entweder von niedriger 

Qualität oder auf das konstante Training in einer einzelnen Anatomie beschränkt. Um diese 

Einschränkungen zu überwinden, wurde im Rahmen der vorliegenden Dissertation ein neuartiger 

Prozess zur effizienten Produktion qualitativ hochwertiger anatomischer Computermodelle und deren 

Implementierung in die virtuelle Realität chirurgischer Simulatoren entwickelt.  

Acht frische humane Felsenbeine wurden mit Hilfe von Digitaler Volumentomografie (DVT) sowie 

optischer Hartschliffhistologie digitalisiert. Die resultierenden multimodalen Bilddaten wurden 

anschließend dreidimensional rekonstruiert und zueinander registriert. Die Segmentierung der 

kritischen Strukturen für knöcherne Segmente erfolgte schwellenwertbasiert, während die 

Segmentierung von Weichgewebssegmenten mit manuellen Methoden erfolgte. 

Sechs Anatomien wurden in den Visible Ear Simulator implementiert und stehen nun auch im Rahmen 

von geführten Anleitungen für verschiedene virtuelle Eingriffe am Felsenbein zur Verfügung. Dazu 

wurden die DVT- und Schnittbild-Datensätze vereint, wobei ein geometrisches Modell zur haptischen 

Simulation auf DVT Basis konzertiert mit einem visuellen Modell auf Basis von Schliffbildern 

zusammenspielt. Manuelle Texturen wurden in jenen Segmenten hinzugefügt, deren Aussehen durch 

die Probenvorbereitung für den Hartschliff kompromittiert wurde. Knochendefekte als Folge von 

Artefakten aus der DVT Bildgebung wurden ebenfalls manuell korrigiert. 

Die Publikation der OpenEar Datensätze und ihre Implementierung in einen Simulator läuten ein neues 

Zeitalter in der Simulation otologischer Chirurgie ein. Es wird nun möglich sein, den Einfluss variabler 

Trainingsszenarien auf den Trainingserfolg zu erforschen, ohne dabei Kompromisse in Bezug auf die 

visuelle Qualität der zugrundeliegenden Datensätze machen zu müssen. Es ist zu erwarten, dass die 

Erfolge der Lernenden auf Grund der verbesserten Anlage von generalisierten Bewegungsabläufen 
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sowie der Erweiterung der Aufmerksamkeit auf mehr anatomische Variablen größer ausfallen werden. 

Einer brauchbaren patientenspezifischen Operationssimulation steht derzeit noch die Qualität der 

klinischen Bildgebung entgegen. Der hier beschriebene Prozess könnte jedoch für die Produktion von 

Trainingsdaten für das maschinelle Lernen essenziell sein, welches für patientenspezifische Simulation 

und augmentierte klinische Realität von großer Bedeutung ist. 

Interaktive Apps auf Basis qualitativ hochwertiger anatomischer Modelle wie in dieser Arbeit 

beschrieben, können zukünftig schon für Studierende der Medizin eine wichtige Ergänzung zu 

anatomischen Lehrbüchern sein. In der Facharztausbildung können das Verständnis der Anatomie 

sowie die Effizienz des Trainings im Präparat verbessert werden. Mit der hier vorgestellten Arbeit kann 

die Relevanz chirurgischer Simulation auch auf fortgeschrittene Lernende erweitert werden, welche 

anatomische Modelle in hoher Qualität und abwechslungsreichere Trainingsoptionen benötigen. 

Weitere Studien sind nötig, um die evidenzbasierte, flächendeckende und systematische Integration 

chirurgischer Simulatoren in das Curriculum der chirurgischen Ausbildung zu erreichen. 
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Foreword 

I still remember when I first met Peter Trier and Mads Sølvsten Sørensen in 2009 at the Computer 

Aided Surgery around the Head conference in Paris in 2009. I was a freshman developer of surgical 

tools for cochlear implant surgery and Peter and Mads were presenting the first version of their otology 

surgical simulator in the anatomical preparation lab. I was deeply impressed with the technology and 

the way young surgeons interacted with the simulator in a natural and fun way.  

From today’s perspective of course the simulator they presented at the time seems prototypical. One 

had to wear red/blue glasses to see a stereoscopic image which falsified the visible colors quite a bit. 

Also, the user interface at the time consisted of dozens of technical controls and keyboard shortcuts 

and was hard to master even in the scales of digital natives. But the core components which make up 

the magic of the Visible Ear Simulator until today were there already. On the one hand it is the 

interaction of the user with the three-dimensional digital model of the human ear through a haptic 

force feedback device, creating a virtual reality experience which really made sense beyond a pure 

showcase for the first time in my personal experience. But most impressive was the quality of the 

underlying Visible Ear dataset which Mads had already started working on more than a decade before. 

The three-dimensional interaction with this high-fidelity digital model of the human temporal bone 

including the use of transparency and sectioning provided insights into the anatomy of the human ear 

which neither textbooks nor cadaveric specimen could provide. 

After Paris, I stayed in touch with Peter and Mads and became a volunteer in the team beta-testing 

every new version of Visible Ear Simulator. Many things have naturally been improved over the last 

ten years. The cluttered user interface was replaced over time by a cleaner design inherently limiting 

the user’s adjustment options to configurations maintaining a realistic simulation. The initial 

stereoscopy concept using red/blue glasses was first updated to polarized 3D screens and finally to the 

digital binoculars of the new and fully digital operating microscopes. The visuals and physics simulation 

constantly evolved with every new version. 

An invariant remark which we heard when presenting the simulator all around the world, was that 

surgeons desired more anatomies to be included in the system. While the benefit of adding more 

anatomies was evident to the developer’s team, there was no clear path towards achieving them. The 

laboriousness of the original cryo-sectioning method used in the Visible Ear dataset was prohibitive to 

scaling up to more anatomies. On the other hand, sacrificing the high quality of the original dataset in 

exchange for a faster ability to create more anatomical models using (micro)CT scans did not seem a 

good option either. The promises of artificial intelligence to morph the Visible Ear dataset to any clinical 

patient CT series could not be materialized either given the time and resources available. 
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When my professional career brought me to Hannover in 2012 to work with the amazing group of 

Professor Thomas Lenarz, things changed. Having access to Peter Erfurt’s specimen preparation 

laboratory and experiencing some of his advanced preparation techniques was a golden opportunity. 

In 2014 the idea of creating a more efficient way of creating digital temporal bones through a 

combination of CT and micro-slicing techniques was born. After a while of experimenting with different 

embedding and imaging techniques in 2015 we had grown confident, that it might be possible to create 

high-fidelity anatomical models of the temporal bone in a more scalable way which could produce 

more models in shorter time. In 2016 we started working with actual temporal bone specimen. Peter 

Erfurt optimized the staining and embedding processes in the first samples Alpha and Beta, while I was 

busy fine tuning the workflow of micro-slicing and optical microscopy. With the support of Samuel 

John, the alignment of slices and reconstruction into 3D could be mastered even though the hurdles 

found were much more difficult and resistant to being overcome than expected. 

The following months appear blurred in hindsight, as I was working long hours every day grinding, 

digitizing, post-processing and segmenting temporal bone specimen. But the privilege of being allowed 

to see the beauty of the human anatomy unfold in front of me with every new slice was more than 

enough reward, and at times the seven minutes between two slices was almost unbearably long and I 

could not stop going before the dawn of morning. 

Once all data was captured it still took a significant period of time and the motivated helping hands of 

Gabriel Ribeiro Dos Santos to finalize the datasets in preparation of publication and to overcome many 

small challenges in the reconstruction, segmentation, 3D modeling and presentation of the data. At 

this point in time, all contributors were dedicated to publishing the datasets in full to enable the 

scientific community to work with the raw data or final result as suitable. We were more than happy 

that one of the most prestigious Open Data journals accepted our work. 

Finally, the time had come to integrate OpenEar datasets into the Visible Ear Simulator. But it soon 

became clear that while much time had been spent to create the “truest” possible digital 

representation of the temporal bone specimen, a real time computer-based simulation of ear surgery 

had additional and sometimes competing requirements. Finding a good compromise between 

maintaining an adequate digital representation of the original specimen while achieving a visually 

appealing and stable simulation resembling temporal bone dissection ultimately required active 

participation of a physician (Mads), a software engineer (Peter Trier) and the data originator (myself). 

We are happy and proud that as a result, Visible Ear Simulator 3.5 features six new anatomies from 

OpenEar.  
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After more than five years of interdisciplinary work of a fantastic team of experts, we’ve been able to 

deliver on the promise of taking high-fidelity modeling of the human temporal bone for virtual reality 

surgical training to a new level which will hopefully extend the possibilities of surgical simulation in our 

field worldwide. I feel deeply grateful for the fantastic experiences during this time, for everything I’ve 

learned and for being allowed to contribute to this fascinating technology. 

 

 

  



11 

 

Introduction 

The evolution of surgical training and education has been closely linked to the history of the art of 

surgery itself. Surprisingly from today’s perspective, the Hippocratic oath in its ancient form explicitly 

forbade physicians to operate on their patients. [1] So surgeons and surgery were historically 

considered separate from medicine for ages, and the history of training of surgeons reflects this. [2] 

While training of physicians was provided within the infrastructure of academic settings relatively 

early, surgery was considered a craft and training of surgeons was hence provided in the form of 

apprenticeships for ages. The concept of apprenticeships is still deeply rooted in training of surgeons 

until today, with senior physicians highly invested and actively involved in advancing the education of 

their assigned residents. [2] With its pivotal teaching paradigm of “See one, do one, teach one” the 

apprenticeship concept is considered the most successful mechanism for knowledge transfer until 

today and has proven to work, in that most surgeons today are a product of this system and performing 

surgery in a successful way. [3] In recent years however, educational aspects of surgical residency have 

come under rising pressure in many clinics as per work-hour restrictions and an increasing 

economization of surgical time, leaving senior surgeons with less opportunity to pass on their 

knowledge to the next generation. [2,3]  

Surgical simulation can be very useful in this context, as it gives trainees the opportunity to learn 

certain aspects of surgery on their own, allowing them to use the valuable time with their mentors 

more efficiently. [4] While surgical simulation reaches back to the first documented surgical procedure 

in ancient India 600 BC where leaf and clay models were used to simulate nasal reconstruction, in 

modern times simulators based on computer technology have seen a distinct rise in interest during 

the last three decades. [5] Numerous simulator systems have been developed for a wide range of 

surgical procedures and many parts of the human body. These simulators offer the advantage of 

allowing distributed surgical training opportunities outside of working hours and eventually even away 

from the healthcare facility. [6] They offer an environment in which trainees have an infinite number 

of attempts in an environment in which it is safe to fail and try out things which would be unethical to 

try in patients. [2] Offering such a stress-free environment and being able to gradually increase the 

complexity of training reduces cognitive load and could make learning more efficient. [7] Gamification 

and competitive elements can be used to boost the engagement of residents in simulation training. [8] 

As a consequence of these advantages, surgical simulation centers have been established in some 

clinics. [9] 

When it comes to simulating surgery of the human temporal bone -representing a particularly 

challenging anatomical area- several training options have been established over the years. While the 

most prominent simulation of ear surgery used is obviously training in cadaveric specimen, such 
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specimens have become a scarce and precious resource. [10] To overcome this scarcity, artificial 

temporal bone models from 3D plastics printing techniques have been established and allow 

simulation with good physical realism despite some need for perfecting the materials and anatomical 

accuracy. [11] Several virtual reality surgical simulators providing immersive training environments 

with the help of advanced computer graphics and haptic force feedback instruments have been 

introduced as further alternatives to cadaveric specimen. The Voxel-Man™ is the only commercially 

available system today [12] and comes with a complete hardware system including two haptic force-

feedback devices and a 3D screen. Several temporal bone simulators are developed in academic 

environments at Stanford [13], Ohio State University [14] and Melbourne University [15] but are not 

available publicly. Finally, The Visible Ear Simulator (VES) [16] is a simulation system, which is available 

as an academic freeware allowing (but also requiring) users to obtain hardware from third party 

suppliers. It has been one of the most far developed systems in the field and is different from 

beforementioned simulators in that it is not based on computed tomography type images, but on the 

sophisticated Visible Ear cryosection dataset [17] of a human temporal bone including soft tissue 

structures. VES is therefore providing a higher fidelity anatomy model underlying the surgical 

simulation compared to other simulators and has demonstrated to be a valid training tool boosting the 

mastoidectomy performance in otorhinolaryngology residents [4]. Unfortunately, high-fidelity data of 

the human temporal bone such as the Visible Ear dataset is not widely available and in fact, the Visible 

Ear remained the only such dataset for more than fifteen years. This means that while VES allowed a 

higher simulation quality when compared to other simulators, it had the disadvantage that training 

was limited to repeating the same training scenario over and over. 

This was identified as a potentially limiting factor for the simulator as it has been suggested in the field 

of motor skill learning that variable tasks practice could provide even better training when compared 

to constant task practice. [18] So, while repetition is an important concept in learning, adding 

variability to the practice task may improve generalization and transfer to novel tasks. [19] 

Interestingly, while novice residents showed a steep initial learning curve when using Visible Ear 

Simulator, studies revealed a plateau in the mean performance around the nineth repetition [20], and 

it could be discussed whether one aspect of this plateau effect is that constant repetition of the same 

scenario just yields no further learning effect beyond a certain point.  

The goal of this dissertation was to develop an efficient novel method enabling the creation of a whole 

library of high-fidelity digital models of the human temporal bone as well as the implementation and 

validation of these models in the Visible Ear Simulator. As the imaging modalities used previously in 

model creation for otologic simulators all had their advantages and disadvantages, we decided to try 

combining the advantages of each imaging modality to achieve the fidelity needed to provide an 
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optimal simulation experience while keeping the effort for the creation of new models at a level 

yielding sufficient training scenarios. The implementation into the virtual reality simulator was seen 

foremost as a software engineering task, but it was clear that a considerable effort should be put into 

validating the virtual dissection experience and eliminate any artefacts in the original data which could 

falsify simulation. 

The results of the research performed within this dissertation are documented in two peer reviewed 

journal publications in which the candidate was the first and corresponding author: 

The first publication in Nature Scientific Data [21] describes the novel process of digitizing temporal 

bones including processing of cadaveric specimen, multimodal imaging of these specimen and 

subsequent reconstruction, registration and segmentation of resulting datasets including a description 

of process errors and limitations. A description of how to access and use the raw data from the 

experiments as well as all results thereof is given as per the open data nature of this publication. 

The second aspect of this work - integration into the virtual reality simulator system- was published in 

Otology & Neurotology [22] and describes data requirements for implementation in the simulator, 

technical details regarding the implementation, postprocessing steps to increase realism of the 

simulation as well as learnings from our research which should be considered when using clinical 

imaging for patient-specific simulation and planning. 
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Background & Summary
Surgical interventions to treat hearing disorders, including hearing implants such as cochlear implants,
middle ear implants or bone conduction implants require profound knowledge of the anatomy of the
human temporal bone1. The level of experience of surgeons is therefore crucial to ensure optimal
outcomes and low complication rates, necessitating extensive surgical training in preparation for ear
surgery2. Until now, surgical training typically takes place in the operation theatres3 and in temporal bone
laboratories, where surgeons are enabled to practice identification of anatomical landmarks on human
cadaveric specimen4,5. However, in many places it has become increasingly difficult to obtain a sufficient
number of temporal bones due to lack of availability because of ethical, cultural, regulatory and/or
financial reasons6. This situation led to the development of alternative training options such as artificial
temporal bones from polymer materials7–14 or computer based surgical simulators, where haptic feedback
devices are used in combination with advanced computer graphics to create a virtual reality training
environment15–19. None of the mentioned systems is meant to entirely replace working with cadaveric
specimen, but all of them offer a hazard free training environment which has the potential to be very
effective in training surgeons at relatively low running costs. In fact, computer based surgical simulation
allows the user to repeat procedures as often as desired while adding a new level of motivation for
training by giving interactive feedback to the trainee. Recent studies20–23 have been able to demonstrate
that with just two hours of self-directed simulator training a significant improvement of temporal bone
dissection abilities measured in cadaveric specimen can be demonstrated in entry level surgeons.

Most of the currently available simulation systems are limited by the fact that they are based on low-
quality datasets. Those datasets are acquired by Computed Tomography (CT) which results in low detail
models and lack of information on soft tissue structures such as membranes. micro CT imaging-based
data might be able to overcome the lack of details, however current Micro CT machines only allow
scanning of small specimen and it is therefore impossible to model a sufficiently big portion of the
anatomy for surgical simulation. For both CT and micro CT based datasets there is no colour information
available and so texturing of models for simulation is performed manually resulting in quite unnatural
colouring. The Visible Ear Simulator (VES) freeware19 available at https://ves.alexandra.dk is currently
the only simulator providing higher fidelity simulation as it is based on naturally coloured cryosection
data24 and 3D rendered at 125 voxels/mm3. On the other hand, as the creation and processing of
cryosection data is extremely laborious, over more than ten years the VES has been limited to only one
anatomy which limits the learning experience by neglecting the significant learning potential of inter
individual variability of anatomy25–27.

The aim of the OpenEar project was therefore to develop a new approach and method which allows
for much more efficient creation of high fidelity coloured models of the human temporal bone. Such an
efficient method was found in the combination of imaging using ionizing radiation and micro-slicing of
cadaveric human temporal bone specimens. Both imaging modalities were three dimensionally
reconstructed, registered and segmented. An overview of all process steps is provided in Fig. 1. As a
result, raster/voxel imaging data of eight digitized human temporal bones is provided, including
segmentations of all relevant anatomical structures and triangulated 3D models thereof. The entire
dataset is provided to the public in full to allow for surgical training or research relying on high-quality
models of the human ear such as navigated/robotic surgery, development of automated segmentation
algorithms and finite-element simulations of the middle and inner ear mechanics.

The OpenEar represents a valuable addition to the datasets which had previously been available to the
field of surgical simulation. Compared to datasets created using clinical CT imaging, the OpenEar dataset
provides a much higher level of detail, particularly when it comes to delicate soft tissue structures such as
the tympanic membrane or basilar membrane. In contrast to datasets based on micro CT imaging, the
OpenEar dataset is able to provide a sufficient model size to cover all aspects of middle and inner ear
surgery and comparable to temporal bone specimen used in clinical education courses.

Like the Visible Ear dataset, the OpenEar dataset provides high fidelity volumetric geometry data
including colour information which enables surgical simulators to be textured based on the actual colours
of the anatomical specimen. This allows to overcome the need to rely on manual false colour texturing
used in simulations based on data from CT/micro CT imaging. The Visible Ear dataset continues to
provide an excellent quality temporal bone model for surgical simulation, while the OpenEar dataset
enriches the learning experience by introducing the significant factor of anatomical variation in eight
unique human ears.

Methods
Eight fresh human temporal bone specimens from four adult subjects were used to create this dataset.
Temporal bones were kindly donated by the Institute of Pathology of the Hannover Medical School. They
were obtained from patients who contributed their corpses to medical education and research. As the
specimens were used anonymously, no approval by the institutional ethical board was necessary.

Specimen Preparation
Specimens were scanned using a 3D ACCUITOMO 170 Digital Cone Beam Computed Tomography
(CBCT) scanner (J. MORITA TOKYO MFG. CORP., Japan) within a period of one hour after specimen

www.nature.com/sdata/
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sampling. Resulting CT images were reconstructed and exported as DICOM using the i-Dixel software
(J. MORITA TOKYO MFG. CORP., Japan) with a voxel size of 0.250 mm.

After CBCT imaging, specimens were cut to fit an embedding mould and fully immersed in a fixation
solution of 4% Formol in phosphate buffered saline (PBS). To allow for better penetration of the fixation
solution and further process fluids into the inner ear lumina, a small opening was drilled into the superior
semi-circular canal, and fixation solution was applied to the superior semi-circular canal using a syringe
and cannula to optimally fix the intracochlear structures. After 72 h of storage in the fixation solution,
specimens were rinsed in PBS to remove Formol from the specimens. The specimens were dehydrated in
four steps by sequential immersion in 70, 90 and 100% Ethanol and afterwards 100% Methanol for 2 days
each. For improved contrast of the soft tissue structures against the embedding epoxy, 0.1% Acid Fuchsin
was added during the Ethanol steps. Afterwards, specimens were dried at room temperature in a fume
hood for about one hour. Finally, the specimens were embedded in epoxy resin (SPECI-FIX 40,
STRUERS, Denmark) to immobilize and preserve any mobile structures inside the temporal bone like
membranes or the ossicular chain during further process steps. To improve penetration of the epoxy resin
into the smaller lumina of the temporal bone, the embedded specimens were put in a vacuum desiccator.
Embedded specimens were cured at room temperature for at least 7 days before continuing with further
process steps.

After embedding, all specimens were scanned again using CBCT, to also capture the outer geometry of
the epoxy overmould to be used for referencing the different imaging modalities. Scanning mode was set
to ‘HiRes’ this time, scanning parameters were set to 80 kV tube voltage, 2 mA tube current, 360°
scanning angle and 60x60mm Field of View (FOV). Reconstruction and DICOM export were performed
in the same manner as before mentioned, but at a 0.125 mm voxel size.

Micro-Slicing
Micro-slicing was performed by sequential grinding and microscopic documentation of the specimens.
Grinding was performed using an AutoMet250 Grinder-Polisher (BUEHLER, Lake Bluff, IL, USA)

Figure 1. Overview of processes used in creation of the OpenEar Dataset.
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equipped with silicon carbide (SIC) grinding paper with a Grit of P 800. After each removal, the novel
layer was documented using a VHX-2000 measurement microscope (KEYENCE Corporation, Osaka,
Japan) equipped with a VH-Z20UR zoom lens at 20x magnification mode using image stitching
functionality. The effective removal was determined by measuring the height of the remaining overmould
using a micrometre gauge.

Alignment of the images from micro-slicing as a prerequisite step for reconstruction of the image
stack, was performed by custom made software using Python scripting and the packages of the Anaconda
collection (Continuum Analytics, Austin, TX, US). A template matching technique was implemented to
align the images along the overmould outline which served as reference geometry due to its relative
invariance across images. A brute force search approach was first used to find the approximate translation
and rotation of the overmould outline in the image, followed by a local optimization method to find the
best translation, rotation, shear and scale of the overmould in the image.

Due to the relatively large size of the images (~3700 × 3700 pixels) the computational effort to perform
such operation makes it unattractive to perform the computation on the central processing units (CPUs)
of modern personal computers. Instead it was decided to implement the described operation on a
graphics processing unit (GPU) which allows for a massive parallelization of the required computations.

Reconstruction/Registration
The slice thickness in histological sections is inhomogeneous as per the unavoidable technical tolerances
of the used grinding process. To be able to use the acquired images with existing software for processing
of medical three-dimensional images, slices had to be homogenized. The aligned images were therefore
interpolated to a homogeneous slice thickness of 150 μm using a virtual image stack. The original images
were put on the positions in the virtual image stack, which came closest to their original position to keep
interpolation related losses in image quality minimal. Those positions in the stack which did not have an
original image assigned to them, were then linearly interpolated between the nearest neighbouring
original images.

Reconstruction of the micro-slicing image stack was performed using 3D Slicer 4.8.0 (http://www.
slicer.org). The data from CBCT imaging was also imported into 3D Slicer as DICOM series. After a
rough manual alignment of the high-resolution embedded CBCT scan with the micro-slicing images, 3D
Slicer’s built-in BRAINSfit algorithm was used to automatically register both imaging modalities. In a
second step, the low-resolution, larger CBCT scan of the unembedded temporal bone was registered to
the high-resolution CBCT scan using a manual landmark-based registration, followed by the automatic
BRAINSfit registration algorithm. After completion of the two registrations mentioned, it became
possible to display all three imaging modalities, the large portion low-resolution CBCT, the high
resolution embedded CBCT and the reconstructed micro-slicing data aligned in parallel.

Segmentation
A threshold supported manual paint segmentation technique was chosen for segmentation of the datasets
using 3D Slicer. Small structures were segmented using the high resolution embedded CBCT dataset to
have access to the best possible image quality. Larger structures were segmented using the larger low
resolution unembedded CBCT scan to be able to model the biggest possible portion of the temporal bone.
Multimodal overlay visualization was utilized in those anatomic structures which are partially delimited
by bony structures and partially by soft tissue structures. Table 1 gives an overview of the anatomical
structures and imaging modalities used for segmentation of these structures.

3D Surface Model Creation
Segmented volumes were converted to three-dimensional triangulated surface models of all anatomical
structures. The bone segment was additionally exported as a voxel model as per the requirements of
surgical simulators. Triangulation was performed in 3D Slicer and included moderate smoothing during
model creation. Finally, the mesh quality and complexity were optimized using free software tools
Graphite, Meshlab and Meshmixer (Autodesk, San Rafael, CA, USA).

Segment Micro-Slicing CBCT Embedded Specimen CBCT Full Specimen

Scala Tympani/Vestibuli X X

Malleus/Incus/Stapes X

Facial Nerve/Chorda X

Tympanic Membrane/EAC X X

Sinus/Carotis Interna X

Bone X

Table 1. Image modality used for segmentation of different anatomical structures.
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Step-by-Step Process Descriptions
Further details on the processes used to create the OpenEar dataset including step-by-step description of
all process steps are included in Supplementary File 1 of this Data Descriptor.

Code Availability
All custom-made software which was created to align and interpolate micro-slicing data is available in full
and without restrictions at the Zenodo open access research data repository28,29.

All software tools used for the postprocessing of image data are either freeware or Open Source where
code can be accessed via the individual software project websites.

3D Slicer is available at https://www.slicer.org/
Meshlab is available at http://www.meshlab.net/
Graphite is available at http://alice.loria.fr/software/graphite/
Meshmixer is available at http://www.meshmixer.com/

Data Records
As a result of the described process we are able to provide three-dimensionally reconstructed, co-
registered sets of CBCT scans and micro-slicing colour images of the human temporal bone. Eight
digitized human temporal bones were uploaded to the Zenodo open access research data repository and
are available for download free of charge through a permanent Digital Object Identifier (DOI) (Data
Citation 1). They may be shared, used and adapted even for commercial use with the requirement of
attributing to this original work as per a Creative Commons Attribution 4.0 License.

Volume datasets from all imaging modalities performed in this project are provided as 3D Nearly Raw
Raster Data (NRRD) images in the final data processing stage. CBCT images are provided as isotropic
voxel data at a resolution of 125 μm. To allow access to the higher in-plane resolution of those images,
micro-slicing data is provided at an inhomogeneous 50 × 50 × 150 μm voxel resolution. Coordinate
directions are invariant across all imaging modalities provided. Additionally, all raw data from the
experiment, including CT scans in DICOM format and micro-slicing images stored as TIFF files are
provided to enable the community to work with the original data and eventually improve the above
described reconstruction, registration and segmentation processes.

Segmentations of scala tympani, scala vestibuli, malleus, incus, stapes, facial nerve, chorda tympani,
tympanic membrane, external auditory canal, sigmoid sinus and dura, carotid artery and bone are
provided at a 125 μm isotropic voxel resolution as 3D NRRD images and can be viewed with any of the
co-registered imaging modalities in the background. Additionally, triangulated models of those segments
are provided with an optimized mesh quality using about 70 vertices/mm2 surface area in Polygon File
Format (PLY) format which can also easily be converted to the common STL file format using 3D Slicer
(e.g. for 3D printing).

The data repository contains a compressed subfolder for each of the datasets labelled with the specimen
identifier. The eight temporal bone datasets were labelled Alpha, Beta, Gamma, Delta, Epsilon, Zeta, Eta and
Theta. The compressed subfolder for each specimen contains the data as described in Table 2.

Technical Validation
The numerical representation of the human temporal bone provided in this work is limited by its nature
to only be able reproduce the colour and structures found in temporal bone specimens ex-vivo and post-
mortem. These may differ from the colours and structures found intraoperatively in patients in-vivo,
despite all efforts to process specimen immediately after becoming available.

Furthermore, several of the process steps in the creation of data may result in certain technical inaccuracies:

● Dehydration of specimens during preparation for embedding may result in shrinkage of certain soft
tissue structures in the embedded datasets. E.g. the facial nerve may shrink and no longer fill out its
bony canal entirely

● Mechanical forces applied for fixation of the embedded specimens in the grinding machine holder may
result in geometric deformations of the specimens in the micro-slicing data

● The stitching of images as performed with the optical microscope may lead to minor inaccuracies in
the optical image acquisition in the micro-slicing data

● The measurement of remaining overmould height after each grinding step in micro-slicing involves a
certain measurement error particularly in a somewhat elastic specimen

● 3D Reconstruction of the micro-slicing data relies on algorithmic identification of the outline of the
specimens embedding as well as the overmould height measurement determining the position of each
slice in the image stack. Above mentioned inaccuracies in the experimental setup as well as numerical
errors may result in reconstruction inaccuracies.

● Interpolation of the reconstructed micro slicing data to create a homogeneously spaced image stack
may result in certain image artefacts.

● Registration of the micro-slicing and computed tomography images is based on the identical accurate
imaging representation in both modalities. As per the above described inaccuracies of both the 3D
micro-slicing and CT image modalities, as well as due to numerical errors in the registration process,
inaccuracies may occur.

www.nature.com/sdata/

SCIENTIFIC DATA | 6:180297 | DOI: 10.1038/sdata.2018.297 5



Regarding the computed tomography imaging, Lund et al.30 found that the accuracy of the
ACCUITOMO CBCT device used in this experiment can be assumed to be below the voxel size of
0.125 mm.

Quantification of the overall accuracy of the micro-slicing data proves more difficult due to the high
number of interconnected process steps and influencing factors, and the possible inhomogeneity of
inaccuracies within the volume. A comparison of volumetric and geometric properties of the final
product from acquisition, reconstruction and registration of micro-slicing with the CBCT as reference

Steps Description of files File format

CBCT Unembedded Folders containing DICOM series of files representing a CBCT scan of the unembedded temporal bone specimen right after specimen sampling
(not available for ALPHA and BETA)

DICOM (.dcm)

CBCT Embedded Folders containing DICOM series of files representing a CBCT scan of the specimen after cutting, dying, drying and embedding into the epoxy
overmould

DICOM (.dcm)

Microslicing Raw Series of images from micro-slicing grinding process, each image documents the embedded specimen after removal of material using the grinding
machine

TIFF (.tiff)

Reconstruction
Microslicing

3D reconstructed colour datasets from micro-slicing after alignment of slices and interpolation to a homogenous spaced image stack as volumetric
voxel data
Transformations: Comma separated value table where each row contains the nine entries of a 3x3 transformation matrix of one micro-slicing
image from the stack in C-like/row-major order

NRRD (.nrrd)
CSV (.csv)

Materials for Reconstruction:
Target images containing the outline of the epoxy overmould used for alignment of the images from micro-slicing
Layer Positions: Comma separated value table with the information on the position of each micro-slicing image in the stack as described by its
distance to the initial slices

GIMP/PNG/SVG
(.xcf)/(.png)/(.svg)
CSV (.csv)

Registred Slicer
Volumes

3D reconstructed grayscale datasets from CBCT @ 125 μm resolution as volumetric voxel data
• CBCT_Unembedded: Unembedded CBCT registered to align with micro-slicing
• CBCT_Embedded: Embedded CBCT registered to align with micro-slicing, resized to the coordinate space size of the unembedded CBCT

NRRD (.nrrd)
NRRD (.nrrd)

Transformations:
Transformation matrices used to register datasets to each other
Accuracy assessment: (not available for ETA)
Meshlab screenshot of the Hausdorff analysis
Text file with results from geometric and volumetric analysis
3D Slicer segmentation file delineating overmould in CBCT and micro-slicing

.H5 (.h5)
PNG (.png)
TXT (.txt)
NRRD (.nrrd)

Segmentation 3D Slicer segmentation file assigning voxels of the registred CBCT volumes to one of the anatomical structures delineated NRRD (.nrrd)

3D Models Triangulated, smoothed 3D models of all anatomical structures as segmented in 3D Slicer after mesh quality optimization
@ ~70 vertices / mm2

Bone volume as volumetric voxel data

PLY (.ply)
NRRD (.nrrd)

Table 2. Data content per compressed specimen subfolder (e.g. Alpha).

Figure 2. Visualization of differences between CBCT and micro-slicing data for the Zeta dataset using the

Meshlab Hausdorff distance analysis.
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was chosen as most viable option. Threshold based segmentations of the epoxy overmould outline in the
CBCT and micro-slicing modalities were analytically compared using the Meshlab Hausdorff distance
filter31 yielding the mean and maximum geometric error between CBCT and micro-slicing. Figure 2
exemplary shows the visualization of the Hausdorff distance analysis and histogram of error for one
dataset. The Meshlab Compute Geometric Measures function allowed for the calculation of the
volumetric error of the micro-slicing image related to the CBCT images. Colour coded is the distance
between the surface of reconstructed overmold geometry from micro-slicing and CBCT imaging. Visible
error/deformations of the epoxy overmold include e.g. screw indentations from mounting the specimen
in the grinding machine holder in different positions.

Results for the geometric and volumetric errors for each of the datasets are summarized in Table 3.
The described analysis could unfortunately not be performed for dataset Eta, due to an artefact in the
CBCT acquisition which made segmenting the overmould outline impossible.

High fidelity surgical simulators currently operate at a voxel resolution of about 125 voxels/mm319 and
a corresponding isotropic pixel size of about 200 μm. The above described accuracies of the CBCT and
the micro-slicing datasets are therefore considered to be acceptable as they lie within the pixel resolution
of the computer simulation which they were primarily created for. However, the OpenEar dataset may be
limited for applications requiring higher levels of detail and accuracy such as e.g. cochlear microanatomy.

Figure 3. 3D Slicer visualization of different imaging modalities of the Theta dataset. (a) Image fusion slice

with 30% CBCT and 70% micro-slicing. (b) Three-dimensional reconstruction of anatomical segments from

delineation. (c) CBCT slice with anatomy segmentation delineation overlay. (d) Reconstructed slice from

micro-slicing.
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Usage Notes
The OpenEar datasets allow for an entirely new view on the anatomy of the human temporal bone. The
co-registration of reconstructed CBCT and micro-slicing data allows for viewing two-dimensional slices
of the ear seamless and/or simultaneous in radiation based and optical modalities. When looking at a
mid-modiolar section of the inner ear, for instance, the CBCT image will give the viewer a solid
understanding of where the bony constraints of the inner ear space are located and allow for semi-
automatic threshold-based segmentation techniques. Being able to amend or change to the information
from the micro-slicing images, on the other hand, allows for a more complete picture and more precise
segmentations as also soft tissue structures like e.g. the basilar membrane or tympanic membrane can
easily be located.

For viewing of the data, 3D Slicer is the recommended free software package which was also used
during the creation of the datasets, however there are numerous software options to work with TIFF,
DICOM or NRRD data which may be considered.

When using 3D Slicer to work with the datasets, it is recommended to load the reconstructed micro-
slicing dataset, as well as the registered 3D Slicer volumes of the CBCT unembedded and embedded
specimen and the segmentation file. Figure 3 shows how to use the ‘Slice Viewer’ controls, to view two
image volumes simultaneously as foreground and background layer, as well as the segmentation overlay
and 3D representation of the geometric segmentation.
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Abstract 
 

Background: Virtual reality (VR) simulation is an established option for temporal bone surgical 

training. Most VR simulators are based on CT imaging whereas the Visible Ear Simulator (VES) is 

based on high-fidelity cryosections of a single temporal bone specimen. Recently published OpenEar 

datasets combine cone-beam computed tomography (CBCT) and micro-slicing to achieve similar 

model quality. This study explores integration of OpenEar datasets into VES to enable case variation 

in simulation with implications for patient-specific modeling based on CBCT. 

Methods: The OpenEar dataset consists of segmented, co-registered, multimodal imaging sets of 

human temporal bones. We derived drillable bone segments from the dataset as well as triangulated 

surface models of critical structures such as facial nerve or dura. Realistic visualization was achieved 

using coloring from micro-slicing, custom tinting and texture maps. Resulting models were validated 

by clinical experts. 

Results: Six out of the eight OpenEar datasets could be integrated in VES complete with instructional 

guides for various temporal bone surgical procedures. Resulting models were of high quality because 

of postprocessing steps taken to increase realism including colorization and imaging artefact removal. 

Bone artefacts were common in CBCT, resulting in dehiscences that most often could not be found in 

the ground truth micro-slicing data. 

Conclusion: New anatomy models are included in VES version 3.5 freeware and provide case 

variation for training which could help trainees to learn more quickly and transferably under variable 

practice conditions. The use of CBCT for VR simulation models without postprocessing results in 

bone artefacts, which should be considered when using clinical imaging for patient-specific 

simulation, surgical rehearsal and planning. 

Keywords: virtual reality simulation; temporal bone surgical training; patient-specific simulation; 3D 

modelling; post-processing.  
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Introduction 
 

Surgery of the human temporal bone requires a high level of understanding with regards to the three-

dimensional location of anatomical landmarks and important neural and vascular structures.1 Training 

of novice surgeons still relies heavily on dissection of cadaveric specimens despite challenges to provide 

enough temporal bones in many centers.2 Surgical simulators can be an important addition to the early 

stage cadaveric training of novice surgeons in temporal bone labs. It is well-documented that temporal 

bone simulators can improve the technical skills of trainees and optimize the potential and efficiency of 

cadaveric training.3 However, patient-specific simulation4 for the more experienced surgeons rehearsing 

and planning in complicated cases may imply higher requirements of realism and quality in simulation. 

Most surgical simulators are based on medium resolution grayscale image data from clinical computed 

tomography (CT)5, which provides no anatomical color information nor detailed geometry information 

on the more delicate bony or soft tissue structures such as the ossicles or the tympanic membrane. This 

low level of graphic fidelity can be a major hurdle in creating realistic and immersive VR environments 

for surgical training and planning.  

A stack of high-fidelity digital image data6 resulting from a laborious cryosection process was used in 

the development of the Visible Ear Simulator (VES) freeware.7 The quality and realism of this 

anatomical model is higher, but the amount of work needed for manual segmenting and rendering has 

yielded only a single anatomy. This is a common concern among teachers and trainees because 

experience from practicing on multiple anatomies (i.e. case variation) is generally considered to be 

important.8 

The recently published OpenEar dataset9 used clinical cone-beam CT (CBCT) and high resolution 

CBCT in combination with anatomical micro-slicing to increase accuracy and efficacy in segmentation 

and to achieve a similar visual quality as the Visible Ear 3D model using a less laborious process. We 

hypothesize that we could apply these datasets to provide additional high-fidelity virtual reality models 

for temporal bone surgical training. 

 

Material and Methods 
 

Data summary 

The OpenEar dataset consists of eight digitized adult human temporal bones available for free download 

from the Zenodo OpenData repository.10 Each dataset in the series is based on a co-registered 

multimodal imaging set, including clinical type CBCT of the entire temporal bone and high resolution 

CBCT, as well as micro-slicing of a cropped specimen as shown in Figure 1 (left). Segmentations (i.e. 

delineations) of scala tympani, scala vestibuli, malleus, incus, stapes, tympanic membrane, facial nerve, 

chorda tympani, cochleovestibular nerve, sigmoid sinus/dura and carotid artery are provided.  

VR simulator 

The Visible Ear Simulator freeware (VES), first published in 2009, has evolved over several iterations 

technologically, didactically, and in relation to the source data material: The first versions (1.0 through 

1.3) focused entirely on the Visible Ear dataset6 whereas version 2.0 introduced a modular software 

concept that allowed developers to load models based on other datasets into the simulator. In this paper, 

we present the integration of the OpenEar datasets9 in the newest version 3.511 that has a fully modular 
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system, allowing for the user’s creation of training scenarios and tutorials as well as user addition of 

new anatomies. 

  

 

Figure 1. Left: An example of the OpenEar dataset (Delta) showing the embedded specimen. Note the 

level of detail and color representation in the micro-slicing data as well as the cochlear compartments, 

modiolus, and osseous spiral lamina being clearly visible. Right: 3D reconstruction of the full dataset 

in the Visible Ear Simulator for surgical training. The embedded part from micro-slicing is highlighted. 

 

Data requirements: drillable bone segment 

In order to integrate new anatomies such as the OpenEar library into the VES, the drillable osseous 

segment of the temporal bone must be available as a three-dimensional, isotropic voxel model at a high 

resolution of 0.2mm or better. For a realistic simulation, two models work in concert: a central 

processing unit (CPU) based haptic bone model, which allows physical simulation of drilling through 

interaction with the user input from a haptic device, and a corresponding graphics processing unit (GPU) 

based model, which provides 3D imaging and advanced optical effects like subsurface scattering. 

Through precise co-registration, the two models are aligned to ensure that the physical and visual models 

interact properly. 

Data acquisition and processing: drillable bone segment voxel pipeline 

CBCT data from the OpenEar library was resampled to an isometric voxel size of 0.15mm using the Fiji 

software12 setting the resolution 25% higher compared to the original Visible Ear dataset to provide 

more anatomical detail. A transfer function was applied in 3DSlicer13 to remove noise and artefacts from 

the scans, identify bone voxels through a Hounsfield threshold limit, and adjust the Hounsfield dynamic 

range to match that of VES. A custom software tool was created to apply slight Gaussian filtering to 

achieve smooth surfaces. Tissue density values for haptic simulation in the simulator were also based 

on CBCT Hounsfield scale data. 

Color data for each bone voxel was derived from the micro-slicing datasets of the OpenEar library. 

These datasets are originally anisotropic due to the nature of the micro-slicing process yielding higher 

in-slice resolution compared to the slice-to-slice resolution. Therefore, these were resampled to an 

isometric resolution. To accommodate the differences in size of the CBCT and micro-slicing datasets, a 

simple algorithm was created to sample colors in the micro-slicing dataset and achieve realistic color 

variation in the remaining bone in the model. 

For manual postprocessing in relation to bony defects, a “voxel spray” tool was introduced into VES 

which can be used to fill artefactual bony voids manually where needed. 
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Data processing of non-drillable segments: triangulated segments pipeline 

Manual segmentations of critical structure segments (nerves, blood vessels, dura) from the OpenEar 

dataset were exported as triangulated surface models. Surface normals were computed for all surfaces, 

and geometric decimation was applied to reduce the number of polygons in some segments which 

yielded models that could not be handled efficiently. Resulting surface models needed to be free of 

CBCT artefacts14 such as holes, internal surfaces, non-manifold geometries and inverted surface normals 

for the sake of realism and to avoid problems in the physics simulation (e.g. contact detection between 

drill and anatomical segment). Therefore, new high-fidelity triangulation meshes with a defined number 

of elements and a uniform triangle size were created to optimize the models for fast real-time physics 

simulation using the Graphite software tool.15 Meshmixer16 was used to repair remaining defects in the 

models, such as noisy surface patches. Meshlab17 was used to check the resulting segments and fix 

instances of inverted inner and outer surfaces, which would make the use of segments in physics 

simulations impossible. 

For the graphical model, additional color maps were created. In the middle ear ossicles each vertex of 

the surface triangulation was assigned the corresponding color value from the micro-slicing dataset 

(Figure 2). Non bony segments such as the dura and facial nerve were colored using UV mapping—a 

computer graphics method to project 2D images onto 3D models. This required the surface of the 3D 

object being UV unwrapped (i.e. a 2D parametrization of the 3D model). A commercial software 

package18 was used to produce the UV maps for the larger models. Color for each element was 

determined by using a search position 0.05mm inside the segment element surface normal to avoid 

artefacts caused by the micro-slicing embedding resin. 

 

Figure 2. An example of modelling based on segmentation of the temporal bone structures. Malleus 

after MeshLab processing (left) and after vertex colorization (right). 

To further enhance the graphic realism of the data, textures were applied with manual painting of blood 

vessels on the facial nerve and dura segments (Figure 3, right) using Blender software.19 This 

enhancement is considered important because the vascular pattern on these structures visible through a 

thin layer of bone can be a visual cue e.g. during posterior tympanotomy drilling. Such optical surface 

information is always lost even in micro-slicing as an inherent artefact of the sectioning, segmentation, 

and reconstruction, in which the reconstructed 3D surface consists of stacked pixels selected 

stochastically on either side of a segment border in a 2D image. Improvements of such visual cues and 

graphics realism in the simulation environment seem to positively impact drilling performance as 

illustrated in the increased average performance (adjusted for other factors) from version 1.3 to version 

2.1 and 3.0 of the Visible Ear Simulator20.  

Some of the segments appeared visually flat despite colorization, pattern tinting and manual 

texturization. In reality, thin segments feature translucency, but most real-time visualization calculations 

-such as those needed for simulation- do not support this because of performance constraints. To 

simulate the effect of translucency, an efficient method was developed to reconstruct a view dependent 



 

 

Otology & Neurotology 2021  5 

model thickness using spherical harmonics.21 To calculate these spherical harmonic coefficients22, a 

signed distance field was computed representing the closest distance to a surface for every voxel, and 

subsequently used inside the shader to simulate translucency in real time. 

The final process step in implementing the triangulated segments was the modeling of collision detection 

and physics. Collisions are detected using signed distance fields. The physics simulation is driven by a 

very simple mesh discretization using only spheres for fast intersection tests and surface skinning.23 

 

Figure 3. Example of texture mapping to enhance realism (Delta OpenEar dataset). Left: UV mapping. 

Middle: Basic color tinting + minor texture. Right: Major texture mapping using artwork created in the 

Blender software. 

 

Validation of visual quality and anatomical validity 

The resulting 3D models including the artistic enhancement of some segments were evaluated by nine 

experienced clinical experts from six clinics in four different countries from a viewpoint closely 

resembling the perspective of an operating surgeon. The experts rated the usefulness of each segment 

for surgical navigation for the newly implemented anatomies from the OpenEar dataset in direct 

comparison to the original Visible Ear dataset using a 5-point Likert scale.  

 

Results 
 

Six datasets from the OpenEar library (Delta, Epsilon, Eta, Gamma, Theta and Zeta) were processed 

using the described pipeline. Datasets Alpha and Beta were not included because the quality was lower 

and not suited for integration. Each of the seven digital specimens (six OpenEar + one Visible Ear 

dataset) can now be used for training in VES—both as a left or right ear through mirroring. The current 

version 3.5 of the Visible Ear Simulator is available as an academic freeware from 

https://ves.alexandra.dk/ and will run on PCs/laptops running 64bit Microsoft Windows 7 or later and 

featuring a sufficiently powerful NVIDIA® graphics processor (RTX2070 or better is recommended for 

optimal performance). A Geomagic Touch® device (3D systems, Rock Hill, SC, USA) is needed for 

haptic 3D control of the interactive surgical tools and for drilling with force feedback. Various tutorials 

for training of novice surgeons are available for each specimen with on-screen step-by-step guides for 

meatoplasty, cortical and full mastoidectomy, posterior tympanotomy and CI insertion, front-to-back 

attico-antro-mastoidectomy, and translabyrinthine as well as fossa media approaches to the inner 

auditory canal. Learning support functions include transparency and slicing to “see into the bone”, 

collision warnings, optional color-coding of bone volumes to be removed (simulator-integrated tutor-

function) corresponding to the step-by-step guides, and even haptic guidance of CI electrode handling. 
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For the integrated OpenEar datasets, the bone segment geometry of the virtual temporal bones was 

created from the clinical CBCT dataset, which has a large field-of-view. This allows simulation of e.g. 

a full mastoidectomy and cochlear implant bed creation. For the core part of the temporal bone for which 

color data from micro-slicing was available (i.e. the embedded specimen), the bone volume is colored 

according to the respective micro-slicing colors (Figure 1, left). This includes the mastoid, external ear 

canal, tympanic cavity, middle ear ossicles, and round window niche. These structures will therefore 

closely resemble the colors found in an actual cadaveric temporal bone. For the voxels outside of the 

micro-slicing dataset, the CBCT bone volume was manually colored (Figure 1, right). The authors have 

made resulting UV maps as well as 3D models including vertex coloring available for the Delta dataset 

as a sample24.  

The authors also evaluated the fidelity of each of the VR models and frequently observed bone voxel 

defects in the 3D models (Table 1), imitating for example a dehiscence at the horizontal or vertical 

segment of the facial nerve, or bony defects at the interface with dura (Figure 4). These defects were 

often less prominent using the high-resolution CBCT as source material when compared to the clinical 

CBCT. However, not all defects were artefacts of processing the CBCT to make 3D models: in a few 

cases, actual defects and dehiscences were also found in micro-slicing. For example, in the Eta dataset, 

a dehiscence of the superior semi-circular canal was found in both the CBCT and the micro-slicing 

datasets; and in the Epsilon dataset, there seems to be an extensive dehiscence of the horizontal part of 

the facial nerve, which in the micro-slicing is merely a partial dehiscence. These examples show that it 

can be impossible to judge whether a bone defect is merely an artefact in CBCT imaging or an actual 

anatomical finding without access to ground truth imaging such as micro-slicing. For the scala tympani, 

several of the OpenEar models had bony voxel artefacts “growing” inside the scala making it difficult 

or impossible to insert a CI electrode in the simulator using the dataset without manual postprocessing. 

Finally, the CBCT models in two cases (Theta and DeltaHR) also capped the incus in an artificial layer 

of bone that is not a part of the structure. 

 

 

Figure 4. Examples of how bony defects appear in the differently processed datasets of Delta during a 

virtual drilling of an anatomical mastoidectomy. Left: The clinical CBCT dataset has large artefacts 

seen as dehiscences at dura and sinus. Middle: The high-resolution CBCT dataset has smaller 

dehiscence artefacts but the ossicles are embedded in bone. Right: The manually post-processed high-

resolution dataset has no bone artefacts. 
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Table 1. Fidelity of virtual reality 3D models before manual postprocessing. All artefacts were 

removed for final integration in VES. 

 

 

 No artefacts or defects, i.e. normal anatomy in micro-slicing as well as the 3D model. 

(+) Bone defect in micro-slicing as well as the 3D model. 

+ Bone voxel artefact in the 3D model only. 

Source 
material 
(resolution) Dataset 

Voxel artefacts/defects in the 3D model 

External 
surface Dura 

Sigmoid 
sinus Labyrinth 

Facial 
nerve 

Lateral 
face of 
carotid Scala tympani Ossicles 

Micro-
slicing 

(50m) 

Visible Ear 
       

CI electrode 
insertion easy 

 

Clinical 
cone-
beam CT 

(250m) 

OpenEar: 
Theta 

       + 
Narrow due to 
artefacts, CI 

electrode 
insertion 
difficult 

+ 
Incus 

capped 
in some 

bone 

OpenEar: 
Zeta 

      ++ 
Very narrow 

due to 
artefacts, CI 

electrode 
insertion 

impossible 

 

OpenEar: 
Gamma 

     + 
Bone 
voxel 
defect 

 + 
Bone 
voxel 
defect 

 
CI electrode 

insertion easy 

 

OpenEar: 
Eta 

 (+) 
Bone 
voxel 

defect in 
micro-
slicing 

too 

+ 
Bone 
voxel 
defect 

(+) 
Bone voxel 

defect in 
micro-

slicing too: 
SSC 

dehiscence 
in fossa 
media. 

++ 
Large 
bone 
voxel 
defect  

+ 
Bone 
voxel 
defect 

+ 
Narrow due to 
artefacts, CI 

electrode 
insertion 
difficult 

 

OpenEar: 
Epsilon 

+ 
Bone 
voxel 
defect 

+ 
Bone 
voxel 
defect 

  +(+) 
Large 
bone 
voxel 

defect. 
Partial 

dehisce
nce in 
micro-
slicing 

too. 

  
CI electrode 

insertion easy 

 

OpenEar: 
Delta 

+ 
Bone 
voxel 
defect 

+++ 
Very 
large 
bone 
voxel 
defect 

+++ 
Very 
large 
bone 
voxel 
defect 

 ++ 
Large 
bone 
voxel 
defect 

++ 
Large 
bone 
voxel 
defect  

+ 
Narrow due to 
artefacts, CI 

electrode 
insertion 
difficult 

 

High-
resolution 
cone-
beam CT 

(125m) 

OpenEar: 
Delta HR 

+ 
Bone 
voxel 
defect 

+ 
Bone 
voxel 
defect 

+ 
Bone 
voxel 
defect 

+ 
Bone voxel 

defect. 
Promontory 

defect 
inferior to 
the stapes 
footplate 

+ 
Bone 
voxel 
defect 

+ 
Bone 
voxel 
defect 

++ 
Very narrow, 
CI electrode 

insertion 
impossible 

+++ 
Incus 

embedd
ed in 
bone 

OpenEar: 
Delta HR 

with post-
processing 

       
CI electrode 

insertion easy 

 
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The fidelity of models can be improved by 1) increasing the quality of the data acquisition (i.e. increasing 

scan resolution), 2) by voxel post-processing and 3) by using texture maps to represent blood vessels 

and other visual cues. The Delta dataset may serve as an example of what was done in VES version 3.5: 

The external surface towards the dura and the sigmoid sinus had many gross defects when the clinical 

CBCT dataset (0.25mm resolution) was used for 3D modelling (Figure 5, left). However, even at a better 

resolution (0.125mm) some of these defects persisted (Figure 5, middle). With manual postprocessing 

using the voxel spray tool and drilling, these defects could be corrected (Figure 5, right) along with 

correction of other bony artefacts such as the incus being embedded in bone (Figure 4, middle), a defect 

of the promontory wall, and bony artefacts inside scala tympani. Finally, adding texture maps (Figure 

3, middle and right) provides further realism of the simulation (Figure 4 middle and right). These 

postprocessing procedures still require extensive manual labor, pushing the time to integrate a new 

anatomy into the simulator to 25-30 hours which could be optimized by automatization over time. 

Ultimately all artefacts mentioned in Table 1 and beyond were removed for the implementation in VES 

during postprocessing of all included OpenEar models. Resulting virtual models included in VES 

version 3.5 provide the highest quality of models for training (i.e. similar to the DeltaHRP in Figure 5) 

approaching a similar visual quality as compared to the original Visible Ear models. Nonetheless, to 

demonstrate the challenges and effects of imaging and postprocessing on fidelity and realism, all three 

Delta models (i.e. based on the clinical CBCT, high-resolution CBCT, and high-resolution CBCT with 

manual postprocessing) are available in VES 3.5. The expert evaluation of the OpenEar models revealed 

similar ratings for the OpenEar models (range avg 3.7-4.1) and the Visible Ear 3.5 models (avg 4.2). A 

clear improvement was found between the low-resolution Delta models (avg 3.4), high resolution 

DeltaHR models (avg 3.6) and final simulator implementation including manual postprocessing 

DeltaHRP (avg 4.1). Questionnaire and detailed evaluation results for individual structures are found in 

Supplemental Digital Content 1. 

 

 

  

 Figure 5. Different 3D reconstructions of the OpenEar dataset (Delta). Left: Model based on the 

clinical type CBCT + automatic smoothing routines. Middle: Model based on the high-resolution CBCT 

+ automatic smoothing routines. Right: Model based on the high-resolution CBCT + automatic 

smoothing routing + manual postprocessing. Arrows mark bony defects (i.e. artefacts). Abbreviations: 

JF - jugular foramen, AVN - acusticovestibular nerve. 
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Discussion 
 

We present a process for developing high-fidelity VR simulation based on the publicly available 

OpenEar datasets. The aim of the OpenEar project was to develop a new method to create digital 

temporal bone specimens in a time efficient way and to focus on those structures needed to adequately 

simulate the most common otologic procedures including middle and inner ear surgery. Even though 

the original Visible Ear data remains unparalleled as a complete digital representation of the human 

temporal bone including e.g. brain and skin segments, the OpenEar data has been successfully used to 

expand the number of anatomies in high-fidelity virtual temporal bone training. A group of international 

experts has evaluated the implementation of the OpenEar anatomies in the simulator and rated the new 

models almost as highly as the original Visible Ear models. The creation of patient-specific high-fidelity 

models for pre-surgical rehearsal and planning requires high-resolution imaging, accurate and fast 

segmentation, as well as methods to warp and apply meaningful coloring to grayscale type data. While 

the latter could be solved in software engineering given adequate time and resources, clinically available 

imaging quality and segmentation methods are currently hindering advances in this field.  

Two studies have investigated the use of clinical imaging for patient-specific VR simulation, with both 

studies based on cadaveric material: Arora et al. used clinical CT25 and Locketz et al. used clinical 

CBCT.26 Both groups report substantial need for manual interaction to achieve usable models. In a recent 

study27, novice simulator users supported patient specific simulator rehearsal before surgery. However, 

this recommendation was based on the drilling of a single bone rendered from microCT, which is not 

applicable for use in patients. 

Our study further highlights that while clinical CBCT can be used to generate patient-specific models, 

there might be considerable defects and artefacts in the resulting 3D models. Most of these abnormalities 

are artefacts resulting from the acquisition, processing and reconstruction of the data for 3D modelling 

and could not be found in the ground truth micro-slicing data material. However, as some of the defects 

represented true defects also found in the micro-slicing data, there is no clinically available way of 

knowing whether defects are true or artefacts from clinical CBCT imaging. Consequently, this might 

mislead surgeons regardless of whether standard review of the clinical imaging is done pre-operatively 

in a clinical imaging viewer (i.e. DICOM viewer) or whether data is modelled for 3D VR visualization. 

The experienced surgeon will be aware of bias inherent to CBCT such as apparent dehiscences but also 

bias due to the reconstruction and visualization in the virtual reality environment. Manual postprocessing 

can of course be added, but besides being time consuming and resource intensive, this provides no 

guarantee of a “truer” representation without ground truth imaging available. 

Nonetheless, 3D modeling offers advantages such as interaction with the dataset through drilling and CI 

electrode insertion. The manual postprocessing with closure of defects and removal of artefacts needed 

for a solid simulation is however still not feasible or attractive in clinical routine where time of 

physicians is extremely precious. We therefore propose to do this mainly when establishing a case 

library for temporal bone surgical training as in this study, which has made six new cases available 

within the latest version of VES complete with many tutorials for drilling mastoidectomy, CI insertion 

and more. The simulator software is provided as academic freeware online.11  

The implementation of the OpenEar datasets represents a valuable extension of the Visible Ear Simulator 

capabilities, as it allows training of surgical procedures covering more anatomical variations without 

sacrificing some of the fundamental advantages of model colorization based on empirically obtained 

data. Being able to offer variability of practice could increase the learning speed in simulator training 

significantly when compared to constant practice28, as it allows learners to sample a useful range of 

parameter-sets (in our case: anatomical variations) and observe outcomes (in our case: surgical successes 
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or traumata) dependent on their actions. Furthermore, Huet et. al.29 found in aviation simulator 

participants, that variable practice training may accelerate the education of attention to more useful 

informational variables. Translated into our application, surgical simulator trainees in constant practice 

settings could e.g. depend too much on a certain anatomical landmark which is prominent in their single 

anatomy scenario. By adding anatomical variation and variable practice to the simulation, trainees would 

realize they cannot rely on this landmark only and add further landmarks into their decision-making 

process, improving transferability of their simulator-acquired skills. With the addition of further 

anatomies it is anticipated, that simulations will stay attractive up to a higher number of repetitions, 

which may aid in internalizing the surgical procedure at an even higher level than what has been found 

in previous work where an apparent plateau in performance is observed after only few repetitions of 

training.30,31  

Even though basic surgical skills can effectively be learned using low fidelity simulation (such as for 

example box trainers in laparoscopy) most studies have only investigated this for novice learners.32 A 

high graphical realism as pursued by the Visible Ear and OpenEar models might be more important in 

complex procedures 33 where accurate visual cues are important and higher fidelity of the simulation is 

beneficial for more advanced learners.34 

Further studies using a contemporary validity framework 35 are needed to demonstrate that the positive 

effects of variability of practice can also be observed in temporal bone surgical simulation and to create 

validity evidence supporting increased fidelity of the graphics.  

After more than 15 one-eared VES years, the OpenEar project has made six additional digital temporal 

bone datasets available to the scientific community. With the integration into the latest version 3.5 of 

the Visible Ear Simulator, these are now also available for surgical training in a high-fidelity surgical 

simulator environment for the benefit of VR training of ear surgery. The modularization of the simulator 

and the possibility for users to create their own tutorials, could take surgical simulation to a new and 

community-based level. This project yielded several simple but novel solutions to technological 

challenges encountered in the process development as well as insights into implications of using clinical 

CBCT for patient-specific simulation. 
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Summary and Discussion 

Within the framework of this dissertation a novel process was developed which allows the relative 

efficient production of high-fidelity anatomical computer models as well as their implementation in 

state-of-the-art virtual reality surgical simulation. Eight fully digitized 3D models of the human 

temporal bone were created and exemplarily integrated into the Visible Ear Simulator. 

Eight fresh adult human temporal bones were scanned using Cone Beam Computed Tomography 

(CBCT), cut to size, stained, dehydrated, embedded in epoxy and scanned using CBCT again. Destructive 

micro-slicing was performed by serial grinding and optical documentation of the revealed layer of the 

epoxy embedded specimen. The resulting image stack was aligned, reconstructed in 3D and registered 

to the CBCT scans of the specimen in full size and after epoxy embedding. Multimodal segmentation 

of critical structures was performed using threshold-based techniques for bone structures and 

threshold supported manual techniques for soft tissue structures. All segmented structures were made 

available as voxel volumes as well as converted triangulated surface models.  

Previous research by other groups has been aimed at providing similar digital representations of the 

human ear. The infamous Visible Human project [23] made the entire human body available in a digital 

format, however despite the immense efforts undertaken to ensure high levels of detail, these 

datasets were not deemed feasible for the simulation of temporal bone surgery. On the other hand, 

they motivated the researchers of the Visible Ear project to commence their work, creating a dataset 

like the Visible Human but dedicated to ear anatomy only and providing a much greater level of detail 

[17]. While this dataset was of excellent quality, the time and effort needed in its production was very 

high with just the time for segmentation alone estimated at 450 hours for one anatomy [16] yielding 

only one digital anatomy out of several years’ work. Rau et. al. [24] developed a method to reduce the 

processing time in micro-slicing by using an automated grinding sectioning and subsequent 3D image 

reconstruction of epoxy embedded specimen. Their work was however focused on the middle and 

inner ear structures and limited to smaller size specimen making it unsuitable for use in simulations 

requiring the full temporal bone to be modelled to achieve enough overview. So the majority of digital 

models of the human temporal bone feasible for surgical simulation are still CT or micro CT based and 

entirely lack color information and, in many cases, the geometrical accuracy of certain anatomical 

structures which are not well represented in CT imaging can be quite poor.  

It was discovered during creation and preliminary presentation of our data that there was a high level 

of interest in the scientific community to obtain access to such digital temporal bone models for 

various applications, some far beyond surgical simulation. It was therefore decided to adjust the 

publication strategy and become as transparent as possible from an Open Science viewpoint with the 
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idea of making the research conducted as accessible, reproducible and community available as 

possible. Three basic principles of Open Science were particularly prioritized in the OpenEar project. 

To improve the accessibility and impact of our work, an Open Access journal was chosen for publication 

of the methodology used and the datasets resulting from the work. Furthermore, to be able to 

guarantee free long-term availability of the results of this work to the scientific community, the 

complete raw data from our experiments and all results from the processes applied were published 

Open Data using the Zenodo repository hosted by CERN data center. Open Source and free software 

were used in this work and all custom created software code within the framework of this work was 

uploaded to the Open-Source platform Github to ensure our work is reproducible and can be improved 

and built on by the scientific community in the future. 

As in the development of any novel process, the creation of OpenEar datasets went through a learning 

curve and some aspects of the process can still be further improved over time. The concept behind our 

experiments is fortunately still considered fully valid and the proposed concatenation of process steps 

described above could serve to create further high-fidelity models in the future. However, several 

details within the described process steps deserve further optimization to improve the data quality 

and/or reduce the effort needed in some of the later steps in the process. While specimen sampling 

did not seem to have considerable negative impacts on the model quality, the specimen preparation 

and embedding techniques could potentially be further improved. For the application in VR surgical 

simulation, it would be advantageous to better preserve the visual properties of the nerve structures 

such as facial nerve or chorda tympani. Eventually the nerves could be subject of a targeted fixation 

avoiding shrinkage during subsequent drying steps. Another potential field for improvements is the 

setup for micro-slicing, where the specimen holder should be optimized such that local deformations 

of the embedded specimen are reduced, which would make correct reconstruction of the data 

significantly more efficient. It could be suggested to use a specimen holder which clamps the entire 

circumference of the specimen with a defined force distributing pressure evenly and consistently 

compared to the current solution which significantly deforms the specimen at the contact location 

with the pointed radial fixation screw. Advances in optical microscopy systems might offer additional 

improvements in optical imaging quality and reduce motion artefacts introduced by the micro-table 

and image stitching functions used in the current work. Further automatization of the process along 

the lines of [24] could further improve the efficacy of the micro-slicing process. Another field for 

potential improvement is the CT imaging used for segmentation of the datasets. The relatively low 

resolution and fidelity of these datasets significantly decreased the efficiency of the model creation 

process in the current work. It would therefore be highly recommended for future work, to perform 

high-resolution, high-fidelity micro-CT imaging or even Synchrotron imaging [25] in addition to the 

clinical CBCT imaging to reduce the amount of manual segmentation needed in model creation. 
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Despite being a significant efficiency improvement in time and resources spent per anatomy created, 

the new process remains laborious. While acquisition of CBCT image can be performed rather fast, the 

micro-slicing process without automatization still consumes plenty of time. The reconstruction time 

for the micro-slicing data could be greatly reduced if artefacts such as the local deformation of the 

embedding overmold could be overcome. Segmentation and integration of datasets into the simulator 

including significant manual editing is additionally time and labor intensive. In summary, in our 

experience, once the described process had been established, the overall time to create a new training 

anatomy in the simulator is significantly lower than e.g., the Visible Ear dataset [16]. However, we are 

evidently still far away from an automated patient-specific high-fidelity simulation without the need 

for a disproportional investment of surgeons’ time. 

While two of the datasets from the initial process development phase had to be excluded for data 

quality reasons, six out of the eight OpenEar anatomies could successfully be implemented into the 

Visible Ear Simulator software complete with instructional guides for different temporal bone surgical 

procedures. The CBCT and micro-slicing datasets were fusioned to achieve this, with the CBCT based 

geometry model for haptic simulation working in a precisely concerted way with the micro-slicing color 

based visual model. Manual tinting was applied in segments which had compromised visual quality as 

an artefact of specimen preparation for micro-slicing. Along the same lines, some bony defects in the 

drillable segments as a result of artefacts in CBCT imaging were manually patched.  

The publication of the OpenEar datasets and their implementation into the Visible Ear Simulator mark 

the beginning of a new era in surgical simulation of otologic surgery. It will now be possible to study 

the effects of variability of practice in temporal bone surgical training without having to make 

compromises when it comes to the visual qualities of the underlying datasets. This is expected to 

increase trainee’s performance in simulation training due to the better development of a Generalized 

Motor Program [18] and training the surgeons attention to more anatomical variables [19]. What is 

still missing in this regard is representations of pediatric anatomy as well as malformed and pathologic 

anatomy. While pediatric specimens remain more difficult to obtain, such specimens could be digitized 

and modelled using the same process which we have described in this work. Providing models of 

anatomical malformations and pathologic ears represents a much greater challenge as the occurrence 

of these special cases is relatively low in the general public and not necessarily obvious in donors which 

are willing to provide their bodies to science post-mortem. 

So, while this work has been able to demonstrate that it is possible to create high-fidelity models of 

the human temporal bone in a relative efficient way, the question remains how useful it is to just 

increase the number of available models of adult temporal bones with normal non-pathologic anatomy 

beyond a certain point. This highlights the need for the above-mentioned focus on pediatric, 
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malformed and pathologic ear model creation. On the other hand, creating more digital anatomies 

might be an important key element on the way to patient-specific rehearsal of surgery based on clinical 

CT imaging, which is considered a technology which could be needed and within reach in the not-so-

distant future. While the current clinical imaging does not provide sufficient resolution and fidelity to 

distinguish between imaging artefacts and actual anatomical specialties (e.g., bony dehiscences), the 

progress made in clinical scanners in the last decades [26] gives hope that sufficient image quality will 

become available in the foreseeable future. To be able to then also provide meaningful coloring for 

such false-colored baseline images, modern day deep-learning techniques could probably extract color 

information from an existing training database which includes ground-truth color data, and apply an 

artificial yet realistic coloration to models automatically created from clinical imaging on this basis. As 

machine learning techniques usually rely on large scale datasets for training, the processes described 

in our work -or an optimized version thereof- could be useful or even a prerequisite in the creation of 

training data for this future technology. Another technology which might require realistic and colored 

visualization based on false-color imaging is the new generation of fully digital operating microscopes 

[27,28] which could project high-fidelity patient-specific digital models into the surgeon’s binoculars 

in an Augmented Reality manner, to further improve patient safety and surgical performance in actual 

patient surgery. Such systems have in fact very similar requirements as surgical simulators aiming at 

high-fidelity patient-specific simulation which could result in interesting development synergies. 

In whatever direction the outlook regarding future developments of our work will develop, what is 

available today already extends the possibilities in surgical training worldwide. The increasing uptick 

in simulator capabilities has not yet been fully reflected in the widespread modifications of surgical 

curricula needed. However, based on our experiences and published data [29] surgical simulation 

training could and should be strategically positioned at several different levels during the career of 

medical students as well as novice and intermediate level surgeons. 

Using simulators and their anatomical models could be of great benefit already in the education of 

medical students. [30,31] While conventional textbooks are always limited by the need to project 

information into two-dimensional images and text description, interactive use of the available 3D 

models can provide students with additional and motivational insight into the tree-dimensional 

geometry of the human temporal bone in our experience. As interactive drilling is not needed for the 

use of simulators as an ‘advanced textbook’ a haptic force-feedback device is not needed in this use 

case, eventually allowing the use of simulators on the students’ own computers. Even when it is 

decided to make a simulation system available for this audience as a centralized service, the risk of 

broken hardware and resulting need of maintenance can greatly be reduced by removal of the haptic 

force feedback device which is more vulnerable than other parts of the simulator due to its moving 
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parts and eventually fragile components. Such system could therefore be a very competitive tool in 

the education of medical students from a cost-benefit perspective. 

Simulation of drilling in the temporal bone including haptic force-feedback could be added in the 

second step of the training and remain exclusively reserved for more far-advanced medical students 

and entry-level residents. At this stage, tutor-assisted and eventually more low-fidelity simulation in a 

single anatomy is an option to keep cognitive load moderate and maximize steepness of the early 

learning curve. [32] There may be further target groups which this stage of training could be relevant 

for to make the clinical processes more efficient, including advanced surgical nurses and other 

healthcare professionals involved in patient treatment which should have a good understanding of 

what is happening in the surgical theatre. 

Once the initial learning curve is completed, it may be advisable to transfer and solidify the simulator 

learned skills in surgical dissection training using physical 3D-printed models of the temporal bone and 

further on in cadaveric specimen under the supervision and with feedback from the mentoring expert 

surgeon.  

The final stage of simulator training might be indicated when the performance in cadaveric specimen 

is deemed sufficient by the mentoring expert surgeon and before moving into operating in patients. 

At this stage, variable practice VR surgical training in a range of high-fidelity anatomy models – as just 

made available by the products of this dissertation- could help to prepare surgeons for some of the 

anatomical variations to be expected in patients and to further improve the efficacy of the continued 

parallel dissection training in cadaveric specimen. [33,34] 

While the general validity and usefulness of surgical simulator training is well proven in literature 

including the studies mentioned above, further studies are needed to support the suggested 

integration into surgical training curriculum or a modification thereof. Most importantly, the positive 

effects of variable practice conditions observed in other fields of education and training [19, 29] must 

be shown to also be relevant in the field of temporal bone surgical training. Such study comparing 

constant versus variable practice conditions using different VES set-ups in the National Danish 

temporal bone course has already been scheduled. Further studies which are considered important to 

boost the creation of an evidence-based training curriculum should be aimed at better understanding 

the correlations between simulator fidelity and training efficacy in learners of different competency 

levels. Based on the literature [32], it is anticipated that low-fidelity graphics could be sufficient in 

novice learners, whereas high-fidelity simulation might prove superior in intermediate and advanced 

learners. 
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To be able to satisfy the need for surgical simulator training worldwide, access to simulator systems 

must be improved on a global scale in the future. Simulators must be affordable and should not require 

the need for users to individually purchase computer hardware and haptic force feedback devices 

needed to make full use of the simulator capabilities.  

A lifetime’s work is probably still needed to carefully develop these exciting technologies further, 

making them a strong and evidence-based integral part of surgical training worldwide. This includes 

not only further technical development of the existing systems, but also their clinical validation, 

establishing simulation centers in all teaching clinics and integrating simulation into the training 

curricula globally as exemplarily described above. Strong partnerships with all stakeholders involved 

in such effort will be needed to succeed. This includes not only the university clinics being the ‘owners’ 

of surgical training, but also e.g. public health insurance providers and industrial partners. If these 

ambitious goals can be met, it is in the strong belief of the author, that surgical simulation in education 

and training has the potential of improving the efficacy of surgical skills acquirement and ultimately 

the lives of patients worldwide. 
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Appendix 

 

Otology & Neurotology – Editor’s Letter of Acceptance for Publication 

 

Otology & Neurotology - Supplementary Digital Content 

SDC Questionnaire Surgical Experts: Evaluation of the VES3.5 OpenEar scenarios and controls. 

SDC Table 1: Average rating of the nine raters for each structure. 

 

Nature Scientific Data - Supplementary Information 

Step-by-Step Protocols of OpenEar Creation Process 

- Protocol of micro slicing of epoxy embedded temporal bone specimen 

- Protocol of creation of target image from image stack 

- Protocol of alignment and interpolation of micro slicing data 

- Protocol of reconstruction / registration of micro slicing data 

- Protocol of segmentation and modeling of anatomy 





Evaluation of the VES3.5 OpenEar scenarios and controls. 

Each page contains two images from a drilled mastoidectomy scenario in the Visible Ear Simulator. 

Please consider if each structure listed is represented in a way that provides useful visual cues for surgical navigation. 

Please rate the quality from 1 (poor-not useful) to 5 (good-sufficient for safe navigation) with X in the following table: 

VES 3.5 Score 

Item 1 2 3 4 5 

Dura      

Sigmoid sinus      

Lateral semicircular canal      

Incus      

Chorda tympani      

Facial nerve      

Stapes      

Round Window      
 

 

 



Evaluation of the VES3.5 OpenEar scenarios and controls. 

Each page contains two images from a drilled mastoidectomy scenario in the Visible Ear Simulator. 

Please consider if each structure listed is represented in a way that provides useful visual cues for surgical navigation. 

Please rate the quality from 1 (poor-not useful) to 5 (good-sufficient for safe navigation) with X in the following table: 

VES 2.0 Score 

Item 1 2 3 4 5 

Dura      

Sigmoid sinus      

Lateral semicircular canal      

Incus      

Chorda tympani      

Facial nerve      

Stapes      

Round Window      

 

 

 



Evaluation of the VES3.5 OpenEar scenarios and controls. 

Each page contains two images from a drilled mastoidectomy scenario in the Visible Ear Simulator. 

Please consider if each structure listed is represented in a way that provides useful visual cues for surgical navigation. 

Please rate the quality from 1 (poor-not useful) to 5 (good-sufficient for safe navigation) with X in the following table: 

VES 1.3 Score 

Item 1 2 3 4 5 

Dura      

Sigmoid sinus      

Lateral semicircular canal      

Incus      

Chorda tympani      

Facial nerve      

Stapes      

Round Window      

 

 

 

  



Evaluation of the VES3.5 OpenEar scenarios and controls. 

Each page contains two images from a drilled mastoidectomy scenario in the Visible Ear Simulator. 

Please consider if each structure listed is represented in a way that provides useful visual cues for surgical navigation. 

Please rate the quality from 1 (poor-not useful) to 5 (good-sufficient for safe navigation) with X in the following table: 

Delta Score 

Item 1 2 3 4 5 

Dura      

Sigmoid sinus      

Lateral semicircular canal      

Incus      

Chorda tympani      

Facial nerve      

Stapes      

Round Window      

 

 

 

  



Evaluation of the VES3.5 OpenEar scenarios and controls. 

Each page contains two images from a drilled mastoidectomy scenario in the Visible Ear Simulator. 

Please consider if each structure listed is represented in a way that provides useful visual cues for surgical navigation. 

Please rate the quality from 1 (poor-not useful) to 5 (good-sufficient for safe navigation) with X in the following table: 

DeltaHR Score 

Item 1 2 3 4 5 

Dura      

Sigmoid sinus      

Lateral semicircular canal      

Incus      

Chorda tympani      

Facial nerve      

Stapes      

Round Window      

 

 

 

  



Evaluation of the VES3.5 OpenEar scenarios and controls. 

Each page contains two images from a drilled mastoidectomy scenario in the Visible Ear Simulator. 

Please consider if each structure listed is represented in a way that provides useful visual cues for surgical navigation. 

Please rate the quality from 1 (poor-not useful) to 5 (good-sufficient for safe navigation) with X in the following table: 

DeltaHRP Score 

Item 1 2 3 4 5 

Dura      

Sigmoid sinus      

Lateral semicircular canal      

Incus      

Chorda tympani      

Facial nerve      

Stapes      

Round Window      

 

 

 

  



Evaluation of the VES3.5 OpenEar scenarios and controls. 

Each page contains two images from a drilled mastoidectomy scenario in the Visible Ear Simulator. 

Please consider if each structure listed is represented in a way that provides useful visual cues for surgical navigation. 

Please rate the quality from 1 (poor-not useful) to 5 (good-sufficient for safe navigation) with X in the following table: 

Epsilon Score 

Item 1 2 3 4 5 

Dura      

Sigmoid sinus      

Lateral semicircular canal      

Incus      

Chorda tympani      

Facial nerve      

Stapes      

Round Window      

 

 

 

  



Evaluation of the VES3.5 OpenEar scenarios and controls. 

Each page contains two images from a drilled mastoidectomy scenario in the Visible Ear Simulator. 

Please consider if each structure listed is represented in a way that provides useful visual cues for surgical navigation. 

Please rate the quality from 1 (poor-not useful) to 5 (good-sufficient for safe navigation) with X in the following table: 

Eta Score 

Item 1 2 3 4 5 

Dura      

Sigmoid sinus      

Lateral semicircular canal      

Incus      

Chorda tympani      

Facial nerve      

Stapes      

Round Window      

 

 

 

  



Evaluation of the VES3.5 OpenEar scenarios and controls. 

Each page contains two images from a drilled mastoidectomy scenario in the Visible Ear Simulator. 

Please consider if each structure listed is represented in a way that provides useful visual cues for surgical navigation. 

Please rate the quality from 1 (poor-not useful) to 5 (good-sufficient for safe navigation) with X in the following table: 

Gamma Score 

Item 1 2 3 4 5 

Dura      

Sigmoid sinus      

Lateral semicircular canal      

Incus      

Chorda tympani      

Facial nerve      

Stapes      

Round Window      

 

 

 

  



Evaluation of the VES3.5 OpenEar scenarios and controls. 

Each page contains two images from a drilled mastoidectomy scenario in the Visible Ear Simulator. 

Please consider if each structure listed is represented in a way that provides useful visual cues for surgical navigation. 

Please rate the quality from 1 (poor-not useful) to 5 (good-sufficient for safe navigation) with X in the following table: 

Theta Score 

Item 1 2 3 4 5 

Dura      

Sigmoid sinus      

Lateral semicircular canal      

Incus      

Chorda tympani      

Facial nerve      

Stapes      

Round Window      

 

 

  



Evaluation of the VES3.5 OpenEar scenarios and controls. 

Each page contains two images from a drilled mastoidectomy scenario in the Visible Ear Simulator. 

Please consider if each structure listed is represented in a way that provides useful visual cues for surgical navigation. 

Please rate the quality from 1 (poor-not useful) to 5 (good-sufficient for safe navigation) with X in the following table: 

Zeta Score 

Item 1 2 3 4 5 

Dura      

Sigmoid sinus      

Lateral semicircular canal      

Incus      

Chorda tympani      

Facial nerve      

Stapes      

Round Window      
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Supplementary Information: 

 

Step-by-Step Protocols of OpenEar Creation Process 
 

1. Protocol of micro slicing of epoxy embedded temporal bone specimen 

 

2. Protocol of creation of target image from image stack 

 

3. Protocol of alignment and interpolation of micro slicing data 

 

4. Protocol of reconstruction / registration of micro slicing data 

 

5. Protocol of segmentation and modelling of anatomy 

 



Protocol of micro slicing of epoxy embedded temporal bone specimen 
 

Aim 

The aim of this process step is to acquire two dimensional images of an epoxy embedded temporal bone 

specimen at as many positions along the long axis of the specimen as possible. This is achieved by 

repeated grinding off a defined layer thickness from the specimen, and subsequent imaging by 2D 

optical microscopy. The layer thickness chosen is a compromise between the level of detail to be 

obtained and the time it takes to process specimen. Processing several specimens at the same time may 

improve the efficiency of the process but add risk of errors/mixup during the process. 

Materials 

- Buehler AutoMet250 with custom made specimen holder 

- CarbiMet P1200 self-adhesive sand paper 

- Keyence VHX-2000 with VH-Z20UR lens 

- Micrometer DIN863 Set for 10-70mm 

- Pressure air 

Time planning 

After a certain learning curve, about seven minutes per slice were needed 

Protocol 

Setup Phase 

1. Setup Microscope 

• Initialize X/Y Stage and Autofocus “Automatically” 

• Adjust “Camera Settings” 

o Shutter: 1/60 sec 

o Gain: 0 dB 

o White Balance: Use the “Push Set” option placing and focusing a piece of white paper at 

approx. the same operating distance as the specimen 

2. Setup Grinding Machine 

• Adjust Settings 

o Depth: 0.2 mm 

o Pressure:  “ZAXIS”, 45N 



o Probe RPM: 40 

o Disc RPM: 500 

o Mode: “COMP” 

o Check in “WATER” Menu that “STAGE” is set to “ON” 

o Mount specimen in specimen holder with minimal hand torque  

3. Setup Micrometer Screw 

• Use probes to ensure calibration is ok 

• Mount micrometer to allow for comfortable working 

 

 

Slicing Phase 

Before starting slicing, please make sure that everything that you need to perform the steps below is 

ready for many hours of work. Keep in mind that the following steps will be of destructive nature and 

cannot be reversed. A CBCT scan has to therefore be performed before starting the slicing process. To 

avoid deformations of the specimen mounting them in the specimen holder the epoxy embedding 

should have hardened at least 1-2 weeks. 

1. Mount the specimen into the specimen holder and tighten screws carefully to avoid deformation of 

the specimen. In case of not using all slots in the specimen holder, use dummy epoxy overmolds to 

avoid any unbalanced mass. 

2. Attach specimen holder to grinding machine 

3. Start grinding machine 

4. After completion of grinding dry the specimens 

• Dry specimen holder and specimens roughly using cotton blanket 

• Dry specimens surface and edges carefully using paper towel 

• Clean surface of specimens using pressure air 

• Visually check surfaces for remaining particles and remove if any are found 

5. Make sure microscope’s X/Y table is centered 

6. Position the specimen holder horizontally under microscope 

7. Align specimen 1 to be roughly concentric with the light source of the microscope 

8. Perform autofocus on specimen 1 

9. Check result of autofocus procedure visually 

10. Set borders of 2D image stitching functionality  

11. Start 2D image stitching 



12. Replace sandpaper on grinding machine while waiting for image stitching 

13. Save image file for specimen 1 (Naming: 000.TIF, 001.TIF, 002.TIF and so on…) 

14. Repeat steps 5-13 (not step 12) for specimen 2 and all further specimen accordingly 

15. Measure remaining specimens height for all specimen and document in excel sheet 

16. Check after every slice that enough specimen is sticking out of the specimen holder. Reposition the 

specimen when needed and carefully tighten screws at lowest possible torque to avoid deformation 

of specimen 

17. Repeat steps 2-16 until the entire temporal bone is gone, or it becomes impossible to further 

advance and reposition the specimens in the specimen holder 

 



Protocol of creation of target from image stack 

Aim 

The aim of this process step is to create a target image which can later be used to align all images from a 

micro slicing dataset. The alignment is performed by identifying and aligning the outline of the epoxy 

overmold in all images of the dataset. Therefore, a target image which is reduced to only contain the 

epoxy overmold outline information has to be created.  

Materials 

• WACOM Pen Digitizer Tablet Small (Model CTL-480 was used here) 

• Gnu Image Manipulation Program (GIMP) version 2.8 

• “Offset Path” script by user “RobA” available from http://www.silent9.com/incoming/scripts/ 

(version 2013-04-24) 

• Micro slicing images, see “Protocol of micro slicing of epoxy embedded temporal bone 

specimen” 

Installation 

• Install GIMP  

• Copy the offset_path.scm script into the GIMP scripts folder where all other ‘.scm’ files are 

located 

Protocol 

1. Choose an image from the micro slicing 

• Preferably from a central position in the image stack 

• Try to choose a slice with minimal defects in the overmold outline 

o No air bubbles 

o No dust/grinding particles 

o No major deformations 

2. Load the respective .tif file from the micro slicing to GIMP2 

3. In the “Import from TIFF” dialog choose to import “Page 1” 

4. Go to “Layer” -> “Transparency” -> “Add Alpha Channel” to add a transparency variable per pixel 

5. Go to “Layer” -> “Duplicate Layer” to add a backup up of the original image 

6. Go to “Tools” -> “Path” to activate the Paths module 

7. Increase Zoom factor to 400% 

8. Create a path along the outline of the overmold outline by left clicking on it using the Wacom 

digitizer; To correct mistaken points use “Strg+Shift” to delete them and draw a new point  

9. To close the path after drawing the last point hold the “Strg” key and click on the first point 

again 

10. Rename the path just created to “Outline” 



11. Right click on the Outline path in the Paths Dialog and choose Offset Paths to run the script by 

RobA. Create and rename two new paths, one which is bigger and one which is smaller than the 

original outline. An offset of 20-50 pixels symmetric in both directions has proven to be good. 

For histologies with more deformation 50 is the better choice, for histologies with no visible 

outline deformation 20 seems the best choice. To get a “one fits all” process we ended up using 

a two-step process with a 50 target to search the rough outline, and a 20 target to find the 

precise outline. 

12. Check the offset outline paths for points which were not correctly transformed. Such points can 

be moved by drag and drop or deleted using Strg+Shift.  

13. Select the smaller outline and go to “Select” -> “From path”,  

14. Go to “Select” -> “Feather” and choose a feathering of 5px 

15. Go to “Edit” -> “Cut”. You should now see everything inside of the inner outline checkerboard 

style 

16. Select the larger outline and go to “Select” -> “From path”  

17. Go to “Select” -> “Invert”, feather as before, cut as before 

18. Go to “Image” -> “Autocrop Image” 

19. Now you may add rotation to the target. Rotating the target may help to overcome false minima 

in the search operation to find the outline in the image. These come from the fact that the 

original unrotated target is not interpolated, whereas all the other transformations of the target 

are interpolated pictures. So the unrotated image might be considered the best fit, just because 

it is not interpolated and results in a false low penalty function result. Rotating the target by 45° 

makes sure that all transformed picture undergo the same interpolation degradation eliminating 

the error source. In a two-step process the second step target must be vertical oriented again. 

To add rotation do the following: 

a. Go to “Tools” -> “Transform Tools” -> “Rotate” and rotate the image 45° (Make sure the 

Layer is selected in the Layers Dialog and in the “Tool Options” there is also “Layers” 

selected 

b. Right-click on the Outline path and select “Duplicate Path”  

c. Rename the new path to “Outline rotated” 

d. Switch “Tool Options” to “Path”, and use the rotate tool again to rotate the “Outline 

rotated” path by  45° 

20. Go to “Image” -> “Canvas Size” and enter an odd number of pixels for both directions (e.g. 

3701x3701px), click on “Center” in the “Offset” dialog 

21. Export the target image by going to “File” -> “Export As”, set File Type to “PNG Image (*.png)” 

22. In the Export dialog deactivate “Save background color” and “save color values from transparent 

pixels” 

23. Export the path by right clicking on Outline rotated and selecting “Export Path”, use .SVG as 

filesuffix 

24. Save your entire work by clicking “File” -> “Save as” 



Protocol of alignment and interpolation of micro slicing data 

Aim 

The aim of this process step is to align all images of a micro slicing dataset by alignment along the epoxy 

overmold outline and subsequent interpolation of the images to allow 3D reconstruction of the dataset. 

Image alignment is performed by combination of a constrained brute search global optimization 

algorithm with a subsequent local optimization to find the transformation between target image and 

search image. Interpolation is performed using a virtual image stack which is filled with the acquired 

images from micro slicing and in which any slices which remain empty are then interpolated from the 

surrounding images.  

Materials 

• Micro slicing images, see “Protocol of micro slicing of epoxy embedded temporal bone 

specimen” 

• Protocol of specimen height progression, see “Protocol of micro slicing of epoxy embedded 

temporal bone specimen” 

• Target Image, see  “Protocol of creation of target from image stack” 

• Anaconda Python distribution plus several packages as listed below 

• Python scripts and iPython Notebooks from Zenodo/Github 

Installation 

1. Make sure to install an up-to-date GPU driver and have an OpenCL compatible GPU 

2. Install an up to date browser e.g. Firefox 

3. Install Anaconda (Version used was Anaconda 3 2.5.0 64bit) 

4. Install Anaconda packages (many downloadable from Christoph Gohlke’s web page) using the 

“pip install” function: 

o Appdirs (version used was 1.4.0) 

o Pytools (version used was 2016.1) 

o Pyopencl (version used was 2015.2.4) 

o Svg.path (version used was 2.1.1) 

5. Download the versions of “pattern_finder_gpu” and “reconstruct_volume_from_RGB_slices” 

used to create the published dataset from Zenodo: 

https://doi.org/10.5281/zenodo.1344923 

https://doi.org/10.5281/zenodo.1400785 

Check the Github displayed on the respective Zenodo pages to check for potential updated 

versions on Github. 

 

 



Protocol 

Image alignment 

1. Launch Anacondas “jupyter” GUI and open the “reconstruct_volume_from_RGB_slices.ipynb” 

notebook from the repository to perform image stack alignment 

2. Scroll down to the “Start of main script” section and adjust the paths to the situation on your 

PC: 

o Set the path to the target image .PNG file  

(See “Protocol of creation of target from image stack”) 

o Set the path to the target outline .SVG file  

(See “Protocol of creation of target from image stack”) 

o Set the path to the folder containing all .TIF files from one micro slicing series 

(See “Protocol of micro slicing of epoxy embedded temporal bone specimen”) 

3. In the “Definition of Search Strategy” adjust settings of the alignment 

o Rescale: Value for downsampling of the image (bigger than 0 and smaller or equal to 1= 

full res). To save computation time reduce this value, to increase accuracy increase this 

value. 

o Angle Range to search in during brute force optimization. Format: (Start_Angle, 

End_Angle, No of steps in between), Choose the search range large enough to be 

confident to be able to find the most rotated image of the stack. Subsequent steps will 

build on the best position found in previous steps, so search range is symmetrical to 

zero typically. Set number of steps sufficiently high to get a smooth curve plot for 

rotation vs. error value for plot = True or plot=’all’ as shown below 

 

o ROI Size for brute force optimization. Make sure the ROI is large enough, to allow for 

finding of the pattern in image. Check the heat plot in plot=’all’ to make sure it looks 

somewhat like below. Note that rescaling between steps can make a larger ROI 



necessary even though the image is already aligned pretty well from previous steps. 

 

o Tolerance in local optimization: The higher the value, the faster the computation, the 

lower the value, the more accurate the result   

4. In the “Execution of Image Alignment” section, adjust parameters to the situation on your PC: 

o Set the write_files variable to the path that aligned images shall be written to. Set it to 

‘False’ if you do not want to write files to disc 

o Set the plot variable to “False”, “True” or “all” to set the level of feedback you want to 

get from the optimization process 

5. In jupyter choose “Cell”->”Run All” from the dropdown menu 

6. The computation will now be performed for every image of the image stack. This can take 

several minutes to several days, depending on the settings chosen above. If errors occur, try to 

debug. If unsuccessful, contact the authors of the code (Daniel Sieber, Samuel John). 

Image Interpolation 

7. Next is the interpolation of the micro slicing images to create a homogeneously distanced image 

stack as required by most medical 3D viewers.  As a prerequisite you need to export the 

positions of the layers from micro slicing as a comma separated value (CSV) list. If you used Excel 

to document slices, create a new tab and copy/recalculate your slice position data such, that 

every row represents one layer, with the first layer located at 0 representing the position of 

000.TIF, and all further rows representing further layers and their distance to the first layer. 

Select all the rows in the column you created and use “Save as” to save as CSV and make sure 

that only the tab you just created is saved when asked. 

8. Launch Anacondas “jupyter” GUI and open the “image_stack_interpolation.ipynb” notebook 

from the repository  

9. Scroll down to “Definition of constants” and adjust the values/paths: 

o targetPixelNumXY: Sets the size to which every image is resampled to in X and Y 

direction, represented by two values separated by a comma; the higher the values 

chosen, the bigger the data volume created , the lower the values chosen the worse the 

image resolution 

o targetLayerSize: Sets the distance between slices in Z direction. Creates a homogenously 

spaced virtual image stack where the layers are spaced according to the value set. 

o csvfile: path to the .CSV file containing the positional data on the micro slicing slices as 

described in 7.) 

o images: path to the micro slicing images plus asterix based file name extension to create 

an image collection for interpolation of the images 



o savedir: path which shall be used to store the images of the virtual image stack 

containing the micro slicing images amended by interpolated images in the empty 

positions in between 

 

10. In jupyter choose “Cell”->”Run All” from the dropdown menu 

11. The computation will now be performed and the original and interpolated images written to 

disc. This can take several minutes to hours, depending on the settings chosen above. If errors 

occur, try to debug. If unsuccessful, contact the author of the code (Daniel Sieber). 

 

 

 



Protocol of reconstruction / registration of micro slicing data 

Aim 

The aim of this process step is to import the aligned and interpolated image stack from micro slicing into 

3D Slicer and to reconstruct the dataset in three dimensions. In a second step the reconstructed dataset 

is registered to the corresponding CBCT datasets to allow seamless simultaneous use of the aligned 

datasets in further process steps.   

Materials 

• Aligned and interpolated micro slicing images, see “Protocol of alignment and interpolation of 

micro slicing data” 

• CT scans of the unembedded and epoxy embedded specimen before micro slicing 

• 3D Slicer multi-platform free medical imaging and computation software  

(version used was 4.8.0) 

• Meshmixer software (version 11.0.544 was used here) 

• Meshlab software (version 1.3.3 was used here) 

Installation 

• Install 3D Slicer software 

• Install Meshmixer 

• Install Meshlab 

Protocol 

 

Alignment 

1. Use the “Load Data” Module, go to the folder where the interpolated micro slicing slices are 

located and select the first image of the image stack. Activate the “Show Options” checkbox and 

make sure that the “Single File” check box is deactivated 

2. Use the “Volumes” Module, go to “Active Volume” and rename the volume to a meaningful 

name like “HISTO”, go to “Volume Information” and set the image spacing to the values which 

were used in interpolation, see “Protocol of alignment and interpolation of micro slicing data” 

3. Check the “IJK to RAS Direction Matrix”. In case the first and second entry on the diagonal are 

negative, means that the X any Y coordinates are flipped. As this may result in issues later, it 

should be fixed now:  

1. Use the “Transforms” Module, go to “Active Transform” and create a new linear 

Transform 

2. Use “Rename current node” to name the transform “FlipXY” 

3. Under “Edit” invert the first and second diagonal entry of the “Transform Matrix” 

4. Under “Apply Transform”, apply the FlipXY transform to the HISTO dataset and push the 

“Harden Transform” button to make the change permanent. 



4. In case you want to use the micro slicing in more than one resolution or an anisotropic/isotropic 

version, steps 1-3 have to be repeated for all datasets  

5. Use the “DICOM” module to import and load the CBCT scan of the embedded specimen, and 

rename it to a useful name like CBCT 

6. In the slice view visualization options set CBCT as foreground and HISTO as background dataset 

and adjust the visibility such that both datasets will be shown 50%/50% (although not yet 

aligned) 

7. Use the “Transforms” module to create a new linear transform, give it a useful name e.g. 

CBCT_InitialGuess, apply the transformation to the CBCT dataset(s) using the “Apply 

Transformation” section, adjust the “translation” sliders in the “edit” section until the two 

datasets fit roughly onto each other. In case coordinates seem flipped, invert the signs of the 

main diagonal entries of the transform matrix. Harden the transformation in the “Apply 

Transformation” section when done. 

8. Use the “Vector to Scalar Volume” module (under Converters) to create a scalar copy of the 

HISTO dataset, rename the new dataset to e.g. HISTO_Scalar 

9. Use the “General Registration (BRAINS)” module (under Registration) and execute a new 

Registration with the following settings: 

• Fixed Volume: HISTO_Scalar 

• Moving Volume: CBCT 

• Percentage of Samples: 0.2 (run it at 0.002 first to see if it runs properly) 

• Slicer Linear Transform: Create a new one called CBCT_BrainsFit 

• Initialization Transform: None 

• Choose “Rigid 6DOF”  

10. Use the “Transforms” module to harden the CBCT_Brainsfit transformation for the CBCT dataset 

11. Use the “Volumes” module to rename the CBCT volume to CBCT_Registred 

12. Use the “DICOM” module to import and load the CBCT scan of the unembedded specimen 

13. Use the “Volumes” module to rename to a useful name like CBCTBig 

14. Use the “Landmark Registration” module (under Registration) to roughly align the big and small 

CBCT scans with the following settings: 

1. Fixed Image: CBCT_Registred 

2. Moving Image: CBCTBig 

3. Use the “Add Landmark” feature to add three landmarks and identify them in both 

scans, for example: 

i. Apex 

ii. Center of RW 

iii. End of Malleus handle 

4. Registration Type: Affine Registration 

5. Registration Mode: Rigid (in some cases Rigid+Scale yields better results) 

15. Use the “Transforms” module to rename the “Transform” transformation from the landmark 

registration to CBCTBig_InitialGuess, apply it to the CBCTBig volume and harden the transform 



16. Use the “General Registration (BRAINS)” module and create a new Registration with the 

following settings: 

1. Fixed Volume: CBCT_Registred 

2. Moving Volume: CBCTBig 

3. Percentage of Samples: 0.2 (run it at 0.002 first to see if it runs properly) 

4. Output Slicer Linear Transform: Create a new one called CBCTBig_BrainsFit 

5. Initialization Transform: None 

6. Choose “Rigid 6DOF” 

17. Use the “Transforms” module and harden the CBCTBig_Brainsfit transformation for the CBCTBig 

dataset(s) 

18. Use the “Crop Volume” module (from Converters) to crop and resample the largest image of the 

scene:  

1. Input Volume: CBCTBig_Registred 

2. Input ROI: Create new Annotation Region of Interest (ROI) 

3. Change ROI size such that all relevant structures are included 

4. Use Interpolated cropping, interpolation option: 

i. Isotropic output voxel 

ii. Scaling factor: 0.5 (To upsample from 250µm to 125µm resolution) 

iii.  Linear interpolation 

19. Use the “Volumes” module to rename the CBCTBig-subvolume-scale0.5  volume to 

CBCTBig_Registred 

20. Use the “Resample Image (BRAINS)” module (from Registration) to resample the CBCT_registred 

volume to have the exact same size and resolution as the CBCTBig_Registred volume for later 

segmentation: 

1. Image to Warp: CBCT_Registred 

2. Reference: CBCTBig_Registred 

3. Output Image: Create new image CBCT_Registred_FullKOS 

4. Pixel Type: Short 

5. Default value: Minimum Value of the CBCT_registred from Volumes module 

21. Use the “Save File” widget to save your work 

Accuracy Check 

Two accuracy check measurements have been implemented for the datasets. The goal is to measure the 

geometric and volumetric errors in the micro slicing data in relation to the CBCT data.  

Geometric error 

The Hausdorff distances from one dataset to another is the distance between one voxel of the 

dataset and its closest voxel on the other dataset. In our case, the measured set is the outline of 

the epoxy mold of the micro-slicing data with the target being the same outline from the CBCT 

data. 



 

1. Create a new Segmentation using the “Segment Editor” Module 

2. First choose the CBCT_Registred_FullKOS dataset under “Master Volume” 

3. Use the “Threshold” Effect and adjust the maximum value to the highest possible value, 

while setting the lower threshold to capture the entire epoxy overmold without getting 

too much noise like artifacts outside the epoxy mold 

4. Now choose the HISTO_Scalar volume under “Master Volume” and use threshold effect 

as in 3.) 

5. Use the “Export Models” function in the “Segmentations” module to export the 

segmentation, creating a new model hierarchy 

6. Use the “Save File” widget to save the models over the overmold, select the .ply format 

7. The models are then imported in Meshmixer to remove all the inner surfaces such as 

only the outer surface of the mold remains. The mesh operations used to do this in 

Meshmixer are Select (S), Replace (R), Remove (X), Invert Selection (I), and Fill (F). 

8. Import the results from Meshmixer in Meshlab 

9. The accuracy measurement is done by measuring the Hausdorff distance between the 

two models (under Filters/Sampling/Hausdorff distance).  

10. The models are then colorized by Vertex Quality (Color Creation and processing/ 

Colorize by Vertex Quality) and a Quality Histogram is created (Render/Show Quality 

Histogram). 

 

Volumetric Error 

The Volumetric Error measurement is also based on the epoxy overmold segmentations from 

the micro-slicing and CBCT data. It gives the volume ratio between the subset of voxels 

contained in only one of the two sets and the CBCT set. 

1. The 3DSlicer outline segments from the previous measurement are used again, the 

inner holes are filled using the Scissors tool. In the “Segment Editor” module a new 

segment named Merged Error is created. Using the Logical operators tool, the error 

between the two segments is computed using the following operations: (voxels of HISTO 

– voxels of CBXT) + (voxels of CBCT – voxels of HISTO). The newly created segment 

represents exclusive or between the CBCT and HISTO segments. This means it contains 

all the voxels that are only in one of the two sets. 

2. The CBCT and Merged Error segments are now exported as ply models in analogy to 

steps 5./6. of the geometric error computation. 

3. Import the two segments in Meshlab. For both model, the mesh volume is then 

calculated using Filters/Quality Measure and Computations/ Compute Geometric 

Measures. The volumetric error calculates as the volume of Merged Error divided by the 

volume of CBCT mesh. 

 



Protocol of segmentation and modelling of anatomy 

Aim 

The aim of this process step is to delineate the different anatomical structures in the reconstructed and 

registered micro slicing and CBCT datasets, to allow subsequent creation of three-dimensional models of 

these anatomical structures. This is done by manual and in some cases, threshold supported 

segmentation techniques followed by an automatic triangulation of the segmented geometries. 

Materials 

• WACOM Pen Digitizer Tablet Small (Model CTL-480 was used here) 

• 3D Slicer latest version (version 4.8.0 was used here) 

• Reconstructed and Registered datasets, see “Protocol of reconstruction and registration of 

micro slicing data” 

• Graphite software (version 3-1 Release 2015 was used here) 

• Meshmixer software (version 11.0.544 was used here) 

• Meshlab software (version 1.3.3 was used here) 

Installation 

• Install latest version of 3D Slicer 

• Install the latest version of Graphite 

• Install the latest version of Meshmixer 

• Install the latest version of Mashlab 

Protocol 

 

Segmentation 

Use the “Load Data” module in 3DSlicer to load the HISTO, CBCT_Registered_FullKOS and 

CBCTBig_Registred datasets, see “Protocol of reconstruction and registration of micro slicing data”. 

Segmentation is performed using the “Segment Editor” module. In the slice view visualization options 

set one of the CBCT datasets as foreground and HISTO as background dataset and adjust the visibility to 

show one of the datasets, or both datasets simultaneously. Which setting to use is dependent on the 

anatomical segment to be deliniated. Most of the segmentation can be done using the CBCT data. 

Micro-slicing data is mainly used to identify fine bony structures (e.g. stapes) and soft tissue structures 

(e.g. tympanic membrane, basilar membrane) and to help finding landmarks (e.g. junction between 

Facial Nerve and Chorda Tympani). 

As an initial step the bone threshold value (BTV) is determined, all voxels with an intensity higher than 

BTV will be considered as bone. The BTV is chosen such that most of the air cells partition are kept while 



no artifact due to soft tissue is added on the surface of the bone. The value must be manually adjusted 

while segmenting, until the resulting segmentations have an adequate size. 

The segments were created in the following order, using the “Add new empty segment” function: 

1) Scala Tympani, Scala Vestibuli, Ossicles, Facial Nerve, Chorda and Carotis 

The “Paint” tool is the main tool used to do the segmentation in these segments and the Digitizer Pen is 

used to control the brush. It is important to always check that two segments are not overlapping by 

setting the editable area to “Outside all segments”. Activating the “Editable Intensity Range” allows the 

user to set a range of voxel values outside of which the tool does not work. For the bony structures, this 

range is from the BTV to the max value. For cavities and other structures, the range is from the min 

value to the BTV. The “Scissors” tool is used to create clean cuts on the outer ends of ducts of nerve 

structures and the Carotid artery. To check the results of segmentation and optimize them, the “Show 

3D” function can be used, this is particularly helpful for surface optimization and small structures like 

the Stapes. 

2)  Tympanic Membrane 

The membrane segment is created using the micro-slicing data. First, the segment is painted on the 

slices where the image is not interpolated (so it’s an original picture of the sample). The gaps between 

each painted slice are then filled using the “Fill between Slices” tool. The remaining holes are then filled 

directly on the 3D window using the “Paint” effect with the “Sphere brush” function activated. 

3) Bone 

The bone segment is obtained using the “Threshold” effect (From the BTV to the max value). The “Keep 

largest island” function from the “Islands” effect is used to discard undesired and unconnected regions 

of the segmentation. The “Scissors” effect is used to remove any possible artifact. The integrity of the 

bone surfaces is checked and holes on surfaces which should be closed are manually closed using a 

sphere brush eventually combined with the “Editable Intensity Range” function and gradually reducing 

the lower value below the BTV value until a smooth surface is achieved. 

In normal temporal bone specimen, the ossicles are not be embedded in bone and the Facial Nerve 

should be surrounded by a bony canal. This can be checked using the “Show 3D” function and if 

necessary the bone segment must be modified using “Paint” and “Erase”. 

4) External Auditory Canal 

Before segmenting the EAC, the holes between the Tympanic membrane and the Bone must be filled so 

that the junction is completely seamless. The EAC segment is then created using the Paint tool. The 

Scissors effect is used to obtain a clean cut at the outer end of the EAC. 

 

 



5) Sinus-Dura 

A large sphere brush (e.g. Size 20) is used to roughly obtain a first version of the segment representing 

Sinus and Dura. The “Keep the Largest Island” operation is used to remove unconnected islands. At this 

point, a lot of the air cells are still filled with Dura. The goal of the next steps is to remove it. The 

“Margin/Shrink” operation is applied with a 3mm margin for example. This operation can take several 

minutes and aims to separate the parts of the segment that are in the air cells from the main island. 

“Keep the Largest island” is then used again. Most of the air cells if not all are empty at this point. For 

the main island to fit the bone again, it is necessary to use the Margin/Grow operation with the same 

margin value as for the Shrink operation. It lasts also several minutes. The outer border of this segment 

must be cleaned using Scissors such as clean cuts are obtained and that the Sinus and Dura are hidden 

behind the bone from the surgeons pre-operative viewpoint. 

 

Modelling 

Once it has made been sure that all segments are acceptable in the 3D view and not overlapping, the 

models are exported using the “Segmentations” module (Operation : Export, Output type : Models) and 

subsequently saved as .ply files using the “Save Data” Widget. The Bone segment is exported as a 

Labelmap (Operation : Export, Output Type : Labelmap) and subsequently saved as .nrrd file using the 

“Save Data” Widget. 

1) Repairing and Remeshing the models 

The steps described in this paragraph are applied for all exported models except for the bone. 

Performing these steps will greatly improve the mesh quality and reduce complexity of the models. 

1) Start the Graphite software 

2) Use File->Load to load the ply file from Slicer 

3) Use the Surface->Repair->repair surface operation with the following parameters  

a. Epsilon: 0,1  

b. Min comp area: 0,03  

c. Max hole area: 1e-3  

d. Max hole edges: 2000  

e. Max degree3 

f. dist: 0,0  

4) Use the the Surface->Repair->merge vertices operation with the following parameter 

a.  Epsilon: 0,01 

5) Remesh the model, this means creating a new mesh based on the former one with a new 

amount of points and improved mesh quality. The operation is Surface->Remesh->remesh 

smooth with the following parameters: 

 



a. Nb points : See table below 

b. Tri shape adapt : 1.0  

c. Tri size adapt : 0.0) 

Segment Stapes 
Incus, 

Malleus 

Chorda 

Tympani 

Tympanic 

Membrane 

Scala Tympani, 

CochleoVestibular 

Nerve 

Carotis, Facial 

Nerve, Scala 

vestibuli, External 

Auditory Canal 

Sinus-

Dura 

Nb  

points 
1000 2000 3000 4000 8000 10000 50000 

 

This should result in a relatively homogenous mesh element size. If this is not the case, the number of 

points may have to be adjusted. 

Once the operation is complete, the newly created remeshed model is exported using the File->save 

current function. 

If needed, open the remeshed model in Meshmixer to fix remaining defects of the surface by replacing 

them using a smoothed surface. 

In the MeshLab software, import the remeshed models. Sometimes the imported models appear with a 

completely dark surface. In this case the surface normal are falsely inverted, this can be corrected by 

applying  the Filters->Normals, Curvatures and Orientation-> invert face orientation. The model is then 

saved again. 
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